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Course Objectives:  At the conclusion of this course, you will be able to: 
 
 

 Identify and address advanced data entry, querying and reporting 
situations 

 
 

 Use ArcGIS, Microsoft Excel, Google Earth and Adobe Acrobat 
Professional as extensions of TAILS  

 
 

 Create, Upload and Export supported files (pdf, csv, excel, kmz, shp, 
etc)  
 

 
 Describe the TAILS relationship with ECOS and end-of-year reporting 

derived from TAILS data 
 
 

 Understand options for and effective management of electronic files in 
TAILS 
 

 Create maps from TAILS and other data layers 
 
 

 Describe new and upcoming features of TAILS  
 
 
 
 
 
 
 
 



Shepherdstown, WV                                             TAILS: Advanced Tracking & Integrated Logging System 
2013                                                                                                  National Conservation Training Center 
 

 

 
TAILS History & Background  
 
 
 
 
Session Objectives:  At the conclusion of this session, you will be able to: 
 
 

 
 Identify the origins and history of TAILS 

 Define the relationship of TAILS to other modules in 

ECOS 
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♦ Office Activity 
Logging System 
(OALS)

♦ Activity Tracking and   
Management System 
(ATAMS)

♦ Other (or no)
Systems

FY 2005 Deployments

More than 20 separate (but nearly equal) systems

Historic ES Field Office Tracking Systems
TAILS:  History and Background
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♦ Invest in a Service-wide system for all ESFOs
Can’t afford to continue redundant, inconsistent efforts

♦ Develop it in phases with Activity-based Modules
Integrate and interconnect Modules (Section 7, Contaminants, etc)

♦ Use Service-wide User Acceptance Team (UAT) to design it
Experience matters, Real world flexibility needs, Buy-in w/ participation

♦ Refine definitions and policies for consistent data
Improve field level understanding of how to respond, why and what to track

♦ Allow for direct End-of-Year performance / other reporting
Use data entered throughout the year as basis, reduce ESFO scrambles

♦ Provide views of data to public and partners
Web-based access to all (limited info – read only) or password secure

♦ System can have core elements uniform, yet be customized
Although a National System – Interface and data collected locally controlled

The TAILS Proposal
TAILS:  History and Background
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What is TAILS ?
♦ A Web-based, password protected, intranet site

♦ Hosted by / Integrated within the Service’s ECOS

♦ Used to record ES Field Office ‘Activities’

♦ Current version has three major Modules
• Section 7 Consultation Activities
• Advance Planning - Federal Activities 
• Environmental Contaminant Activities

♦ Additional Modules are under development

♦ Has a Flexible Data Model/Customizable Interface
ECOS = Environmental Conservation Online System

TAILS:  History and Background
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Who are the TAILS users and how do they use it?
♦ Field Offices

– Who’s doing What for 
Whom, Where

♦ Regional Offices
– Which Species, What 

Activities, How Soon

♦ Washington Office
– Efficient and supportable 

performance/other reporting

Who is assigned to . . .
Make a map of . . .
Where is the file on . . .

Which Species is . . .
The #1 Activity that . . .
Get Admin Record for . .

All the Details

Management Scenarios

Accounting / Reporting
How many Formal . . .
How many Acres . . . 
How much Money . . .

♦ Partners / Constituents
– Valuable but limited access 

to web-based reports

Inquiring / Locating
When will . . .
What was the decision on .
What recommendations . .

TAILS:  History and Background
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What Does TAILS Provide to the Service?
♦ Continues to Provide for Field Office operational needs
♦ Provides for Regional Office management/budget needs
♦ Increases consistency in data collected (definitions/polices/interface)
♦ Responds to Washington Office accountability/reporting needs
♦ Provides easy access to defensible (audit survivable) data records
♦ Consolidates redundant efforts & shows fiscal responsibility
♦ Does so while adhering to all security mandates/protocols
♦ Provides improved data integration (ECOS and web)
♦ Includes an efficient, expandable system design
♦ Reduces training costs
♦ Provides professional Technical Support (ECOS Help desk)
♦ Provides access 24/7 from remote locations with little down time
♦ No cost aggregation to Regional and Washington Offices
♦ Flexibility for users (ESFOs decide how detailed they record)*
♦ Becomes more customer-oriented to public/partners
♦ Improves support with Washington signoffs and funding

The Investment is not just to the ‘The System’ (Hardware/Software), but also to an 
expanding philosophy of service, transparency and accountability gains as a result of 
staff data-entry time costs.  A time and energy investment with benefits exceeding costs.

Beyond
performance-based,
Nationally required

fields

TAILS:  History and Background
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TAILS:  History and Background

What Office Efficiencies can TAILS Provide?
♦ Allows for default settings, auto-fill, templates (coming)

♦ Eases secure access to information (via FWS intranet)

♦ Provides secure/assured document storage (ECOS Digital Library)

♦ Provides robust and integrated search capability
♦ Provides common reporting tools (Adobe Acobat, Microsoft Excel)

♦ Provides Mapping connections (ArcGIS, TAILS Mapper, Google Earth)

♦ Promotes cross-sharing of information (Intra/Inter-Office/Agency)

♦ Increases transparency of workload/resource requirements
♦ Realizing reduction / elimination of double-logging
♦ Expanding data integration within ECOS / Other Systems
♦ Improving office flow / Reducing handling time
♦ Greatly reducing EOY Reporting and data calls drain
♦ Reducing training costs, Expands capabilities and much more



TAILS
Phase 5

T
A
I
L
S

racking

ntegrated

ogging

ystem

nd

8

What Information can TAILS Collect?
♦ Section 7 Consultations

• Consultation ID, Name, Description,
• Consultation Type, Complexity,
• Action/Work Type,
• ARRA funding source, 
• Species involved, surveyed for, found,
• Lead Staff, Supporting Staff, Hours,
• Date Started, Date Due, Date Concluded,
• Biological Conclusion, Critical Habitat,
• Species Take,
• Action Agency, Supporting, Contacts,
• Location (TRS, Watershed, Lat/Long),
• What is it related to (Fire, FOIA, etc),
• ‘Events’ that occurred (site visit, call, etc),
• Other ‘Activities’ that it relates to,
• File names/locations and uploads and much, much more

TAILS:  History and Background
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TAILS:  History and Background

♦ Conservation Planning Assistance
• CPA Activity Name and Description,
• Action Agency, Supporting, Contact,
• Authority Response Type,
• ARRA funding source,
• Trust Resources involved,
• Lead Staff, Supporting Staff, Hours,
• Date Started, Date Due, Date Concluded,
• What were the Recommendations,
• What Mitigation occurred,
• Habitat Type Protected/Restored, Acres,
• Species-related measures,
• Scale / Level of Approach,
• Location (County, Watershed, Lat/Long),
• ‘Events’ that occurred, Documents uploaded, and much, much more

What Information can TAILS Collect?
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TAILS:  History and Background

♦ Contaminant Activities
• Contaminant Activity Type,
• When and Where it occurred,
• Contaminants involved,
• Suspected Responsible Party,
• Species / Habitats / Refuges involved,
• FWS Position,
• What does it relate to (NRDA?),
• Remediation/Restoration activities,
• Lead Staff, Supporting Staff, Hours,
• Date Started, Date Due, Date Concluded,
• Action Agency, Supporting, Contacts,
• Location (County, Watershed, Lat/Long),
• ‘Events’ that occurred, 
• Associated documents / locations and much, much more

What Information can TAILS Collect?
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TAILS:  History and Background

The Flexible TAILS Data Model
Each Office decides how detailed they want to log

Super
Bundle

Bundle Bundle

Event Event Event Event Event Event Event

Activity Activity Activity Activity Activity
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TAILS:  History and Background

TAILS has Standards but is Customizable
Each Office defines (to some degree) their interface
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TAILS:  History and Background

TAILS allows for Flexible Business Processes
Each Office retains their own Business Process Model
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TAILS Provides Robust Logging & Searching

Home Page

Find Existing

Start New

Add Details

Add Events, Upload Documents

Get Comprehensive, Targeted Reports

TAILS:  History and Background
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TAILS Provides Powerful Reporting/Exporting

• Reports are available at Staff, ESFO, Regional Office and Washington Office levels
• Time-stamped Report Results portray feedback on the query performed
• Report Exports include Comma-separated Value (CSV), Excel, PDF, and ArcMap (GIS)
• Report Results may also be directly mapped (without true GIS) to the TAILS Mapper
• Microsoft Excel and ArcMap are seen as extension tools to TAILS (no reinvention)

Query
Definition
feedback

Varied export options
include

On-line TAILS Mapper

TAILS:  History and Background
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Example: Reporting and Exporting
Administrative Record Report

There is a large number of pre-canned, 
topical Reports in TAILS designed to 
make access to TAILS information quick 
and easy.

There is also a very robust Ad-Hoc Report 
tool that allows users to make custom 
reports

One very powerful Ad-Hoc Report under 
development is the ‘Administrative Record 
Report’, which also assists with FOIAs and 
other tasks and is planned to:

• Allow robust user query / subsetting / content control
• Gather appropriate Activities, Events, etc
• Create an Index file of assoc electronic documents
• Export (en masse) to Excel the index and linked docs 
• Starting Point for CD/DVD creation for AR, FOIA 

(e.g., All Section 7s for the last 5 years that had anything to do with Jaguar)

TAILS:  History and Background
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TAILS allows Reporting & Mapping Extensions
Microsoft Excel used as extension to TAILS ArcMap used as extension to TAILS

Adobe Acrobat used as extension to TAILS Google Earth used as extension to TAILS

TAILS:  History and Background
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Example: Mapping Extension

Google Earth used as extension to TAILS

Google Earth Street-level View

TAILS:  History and Background
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TAILS:  History and Background

TAILS Provides direct EOY Performance Reporting

IPaC: Information, Planning and Consultation System;  ROAR:  Recovery On-Line Activity Reporting;
TAILS:  Tracking and Integrated Logging System;  TESS: Threatened and Endangered Species System;

Measure
Rule / Logic 

Engine

Reports
• ESFO Counts
• RO Rollup
• WO Rollup

TESS

ROAR

EP
Reporting

DOI

• Data review throughout year
• Access to Rules / Logic
• Data ‘adjustment’ during

reporting window

• Data entry and review throughout year 
• On-line aids to assure complete 

and accurate logging

For example: 14.1.2.1:
Timely Non-Hydro Energy
• Section 7,
• Formal / Informal,
• Non Hydro Energy,
• Completed this FY
• Timely

• Data review during
EOY window only

IPaC

TAILS

Enterprise
Planner

PRS: Performance Reporting System



TAILS
Phase 5

T
A
I
L
S

racking

ntegrated

ogging

ystem

nd

Service Performance Reporting:  How it works

For example: 14.1.2.1:
Timely Non-Hydro Energy
• Section 7,
• Fomal / Informal,
• Non Hydro Energy,
• Completed this FY
• Timely

TAILS:  History and Background
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Service Performance Reporting ECOS Integration

Yep, 
count this one

PRS Report
For example: 14.1.2.1:
Timely Non-Hydro Energy
• Section 7,
• Fomal / Informal,
• Non Hydro Energy,
• Completed this FY
• Timely

TAILS:  History and Background
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How many do I log?

These inconsistencies are not as a result of TAILS, but rather TAILS 
has ‘exposed’ them more (and is helping to address them)

A single letter comes in to the Field Office, outlining consultation on the next 
several months work for a Communications Company (20 new towers).  It’s 
found that 18 towers will have ‘No Effect’ while one ‘Is Likely to Affect’ and 
another will cause ‘Adverse Modifications’.  How many Consultations ?

Performance Measures and Workload Factors
—Section 7, Consultations—

Policy Example

A single letter comes in to the Field Office, outlining consultation on the next 
several months work for a Communications Company (20 new towers).  It’s 
found that 18 towers will have ‘No Effect’ while one ‘Is Likely to Affect’ and 
another will cause ‘Adverse Modifications’.  How many Consultations ?

One, definitely

Twenty, no doubtThree, perhaps

TAILS:  History and Background

TAILS and Lingering Consistency Issues
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The term “Technical Assistance Requests Received” includes any written 
communication, including email notices, asking the Service to attend 
meetings, visit sites, comment on documents, conduct studies, or complete 
some other significant task.  Do not include telephone calls or minor emails, 
unless they constitute a specific request to:  participate in a meeting, 
including a conference call; provide comments in writing; or complete some 
other significant task. 

Performance Measures and Workload Factors
—Project Planning and Other Select Programs—

TAILS:  History and Background

Define ‘significant’

Guidance Example

These inconsistencies are not as a result of TAILS, but rather TAILS 
has ‘exposed’ them more (and is helping to address them)

TAILS and Lingering Consistency Issues
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What we’ve done so far
♦ Reviewed all known Tracking Systems and Invited Leads

♦ Requested and received WO and ARD approval to proceed

♦ Received Development & Operations and Maintenance $$

♦ Established and are renewing User Acceptance Team (UAT)

♦ Assured user base (over 1,200 staff) drive development

♦ WO program leads providing standards and guidance

♦ Management Team meets regularly to define/prioritize

♦ Trained numerous ESFOs (NCTC, on-site, web-based)

TAILS:  History and Background
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There is More Work to be done
♦ Add additional Modules and Features, Increase integration

♦ Identify partners who can get valued returns & can contribute
– (DOD, DOT, etc)

♦ Develop FWS User Community Forum
– Best Practices, Success Stories, ListServe, Partnering Techniques, 

♦ Strengthen web site for Audited User Feedback

♦ Development of Tiered Training Mechanisms

♦ Identify Public Access Policy and Deploy

♦ Define Evaluation Criteria & Perform Measures

TAILS:  History and Background
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TAILS Usage (through FY 2009)
Activities logged by Office

Number of Activities

TAILS:  History and Background

• Offices using TAILS:   88
• Loggers:  ~ 1,350
• Electronic Docs IDed > 96,000
• Activities Logged: > 300,000
• Web hits/mth: max 2.2M (Aug 09)
• ECOS Integration:  Significant

• Basis: Section 7, CPA Activities, Contaminant Activities; through Sept 09;
Select legacy data have been uploaded from R2 and Sacramento back to 1977

!
!

!

!

!

!

( > 15,000
( 10,001 - 15,000
( 5,001 - 10,000
( 3,001 - 5,000
( 1,001 - 3,000
( < 1,000

• A number of sub-offices log to their Home Office and are portrayed as such
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TAILS Management Team
– Daniel Brown

Portland , OR Regional Office, Section 7 Regional Coordinator

– Jason Duke
Cookeville, TN – Ecological Services Field Office

– Gina Egusquiza
Boise, ID – Ecological Services Field Office

– Mark Jacobsen
Albuquerque, NM – Ecological Services Regional Office

– Greg Masson
Arlington, VA – Fisheries & Habitat Conservation

– Jason Miller
Arlington, VA – Conservation Planning Assistance

– Linda Purviance
Arlington, VA – ECOS Coordinator - Office of Program Support

– Mark Richardson
Shepherdstown, WV – National Conservation Training Center (NCTC)

TAILS:  History and Background
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TAILS

History and Background
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Advanced Data Entry 
 
 
 
 
Session Objectives:  At the conclusion of this session, you will be able to: 
 
 

 
 Describe and define the TAILS data model 
 
 
 Identify advanced logging considerations for each of the 

TAILS modules 
 
 Explain how TAILS can be customized in a variety of 

ways. 
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Overview

Environmental Conservation Online System
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What is ECOS ?
 Joint effort between Ecological Services and the 

Fisheries & Habitat Conservation Program
– Endangered Species
– Contaminants
– Partners and Coastal
– Conservation Planning Assistance (Federal Activities)
– Fisheries and Hatcheries

 Result of over eighteen years of development

 Team of contract professional developers and 
technical staff as well as support personnel

 FWS Program Manager, in Washington Office

 Servers and staff located in Fort Collins, CO

Environmental Conservation Online System (ECOS)
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Who does it serve ?
 Public ECOS 

• Outreach, Education and Distribution
– Threatened and Endangered Species Information
– Critical Habitat display, GIS file and FGDC Metadata downloads
– Fisheries and Fish Passage, Conservation Plans and Agreements
– Federal Register document display and distribution
– Species queries and summary reports
– Much more

 Secure ECOS 
• Version for FWS personnel only
• Registration required – user name/password
• Single point of access to create and manage information in 

many subject areas
• National Focus Area Support System 

– Integrates selected data from ECOS modules
– Visual display on a map for decision support

Environmental Conservation Online System (ECOS)

http://ecos.fws.gov

https://ecos.fws.gov
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How does ECOS support FWS mission ?

 ECOS facilitates “working with others” 
• Other federal, state, and private organizations
• Other DOI organizations
• The public
• Within the Service

 ECOS educates the public, Congress, and others by
• Providing valuable information about environmental and 

species issues 
• Explaining how we spend their tax dollars 
• Reporting on our activities

Environmental Conservation Online System (ECOS)

“The U.S. Fish and Wildlife Service's mission is, 
working with others, to conserve, protect and enhance 

fish, wildlife, and plants and their habitats for the 
continuing benefit of the American people.”
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How being part of ECOS benefits TAILS

 ECOS manages performance reporting for many subject areas
• TAILS provides integrated logging of data used in performance 

reporting
• TAILS data automatically rolls these data up to ECOS Performance 

Reporting System (PRS)
• Eliminates “double counting” and data call / end-of-year scrambles
• Helps to achieve accurate, consistent and defensible reporting

 ECOS supports cross-program integration 
• TAILS closely integrates (or will) with IPaC, ROAR, HabITS, etc

– TAILS data shared with other ECOS modules
– Other ECOS Modules share with TAILS

 ECOS provides GIS and Reporting capabilities and integration
• TAILS takes advantage of ECOS’ technologies and backbone

 The ECOS team provides Helpdesk, full-time system 
administration, security, and many other services for all modules
• TAILS is able to leverage these resources

Environmental Conservation Online System (ECOS)
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Major ECOS Modules
Environmental Conservation Online System (ECOS)

Threatened / Endangered
Species System

(TESS)

Federal Register

Candidates / Petitions

Recovery On-line
Activity Reporting

(ROAR)

Species Information
Species Profiles

Tracking and Integrated
Logging System

(TAILS)

Litigation

Information Planning
and Consultation

(IPaC)

Habitat Information
Tracking System

(HabITS)

Fisheries Information
System
(FIS)

Fish Passages
Decision Support
System (FPDSS)

Contaminant
Assessment Process

(CAP)

Contaminant
Investigation

Database (CID)

Environmental Contaminants
Data Management 
System (ECDMS)

Major ECOS Tenets:
Maximum Integration

and
No Double Logging

Performance
Reporting System

(PRS)

Critical Habitat
Consulted-On

Effects Database
(COED)



TAILS
Phase 5

T
A
I
L
S

racking

ntegrated

ogging

ystem

nd

7

How can ECOS help you do your job ?

 Endangered Species information
• Portable Document Format (pdf) 

– Federal Register Listing Notices and Rules
– Recovery Plans
– HCPs, CCAs, SHAs, CCAAs

 Interactive Maps (e.g., Critical Habitat)

 Species History, Status, Distribution, Lead, etc

 Links to other resources (and more info on secure site)

 And much, much more – Let’s explore!

Environmental Conservation Online System (ECOS)

http://ecos.fws.gov

Provides access to:
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Overview

Environmental Conservation Online System
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The TAILS Data Model
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Or not

Activities may contain
Events

Overview
TAILS:  The Data Model

The Data Model is organized into a four-level hierarchy

Super
Bundle

Bundle Bundle

Event Event Event Event Event Event Event Event Event

Activity Activity Activity Activity Activity Activity Activity

A SuperBundle may contain
one or more Bundles

only required component
Activities                are the

Bundle

Bundles don’t need 
SuperBundles

A Bundle may
contain one or more

Activities

Events may be
logged directly

in Bundles
You can simply
log an Activity
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Activity:ESFO Activity
(Section 7 Consultation - 21420-2001-F-0133)

Consultation Code = 21420-2001-F-0133
Consultation Title, Description, Type, 

Location, Action Type(s), Associated File(s)
Dates, Species, Biological Conclusion(s), Staff, etc.

Action/Work Type: A category of the physical actions identified by the Action
Agency or typically assumable with this circumstance or development actions.
Examples:  Development – Commercial,

Agriculture – Pesticide Use,
Transmission Line -Electrical

Type: (Consultation Type).  Examples: Formal, Informal, Technical Assistance.

Title: A concise textual identification of the 
consultation, activity or incident.
Example: El Paso Electric Company 2.6 mile 
powerline from Commerce power plant to El 
Raton, NM.

Multiple Action/Work Types can be
Identified for each TAILS Activity Record.
The master list is customizable by Module

Activity: An overall work 
activity taken by a Field, 
Regional or the 
Washington Office in 
response to a request for 
technical assistance or an 
official opinion.  This work 
has many forms, including 
Section 7 consultations, 
permit reviews, or spill 
responses, to mention only 
a few.

Activities
TAILS:  The Data Model
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Event:

ESFO Activity
(Section 7 Consultation - 21420-2001-F-0133)

Event 1
Date: 4/12/2001
Type: Correspondence / Communication Received
Description: Request for Consultation
Staff:
Documents: K:Sect7:2001-0133:Request_1.pdf

Event 2
Date: 4/19/2001
Type: Meeting / Conference
Description: Conference Call for review of 
measures.
Staff: Kern, Craig, Hogan
Documents: K:Sect7:2001-0133:Call_1_Notes.doc

Event 3
Date: 5/6/2001
Type: Site Visit
Description: On-site review of development
Staff:  Hogan
Documents: K:Sect7:2001-0133:SiteReview_1.doc

Event: Generally an initiating or interim instance of a request for our assistance, 
internal actions taken as part of the overall response and juncture decision points 
throughout the Activities life, such as meetings, telephone calls, literature reviews, 
site visits, document exchanges, determinations or similar instances associated 
with an Activity or Activities.

Event 4
Date: 6/1/2001
Type: Correspondence / Communication Sent
Description: Evaluation letter sent to Army Corps
Staff: Hogan
Documents: K:Sect7:2001-0133:Eval_1.pdf

Examples:

Used in developing           
the logical sequential 

record of Service 
actions and 
decisions.

Events
TAILS:  The Data Model

An optional feature
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Bundle

Example:

Bundle: An inter- or intra-
module bundling of 
Activities. Bundles may be 
derived from real 
circumstances 
(development proposals, 
regulatory actions, or 
planning processes) or any 
set of circumstances that 
makes sense to the user.

A Bundle
(TAILS Bundle Code: 21420-2001-B-003)

TAILS Bundle Code: 21420-2001-B-003
Bundle Name, Description and

Activities to associate with Bundle

TAILS Bundle Code: 21420-2001-B-003
Bundle Title:  Barker Dam
Bundle Description: Reconstruction of hydro dam at Barker Reservoir.

(Section 7 Consultation: 21420-2001-F-0133)

(Section 7 Consultation: 21420-2002-F-0065)

(Federal Activity: 21420-2001-FA-0007) Events
Activities

Bundle

TAILS Bundles are designed to allows two or
more TAILS Activities to be associated with
one another.

Bundles
TAILS:  The Data Model
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Why make a Bundle?

Bundles
TAILS:  The Data Model

When it makes sense to you!

To acknowledge and formalize a relationship
between two or more Activities.

Why NOT make a Bundle? If the relationship exists in data!
If you’ve selected data attributes that ALONE define
the relationship you wish to acknowledge and retain

For example
Then DON’T make the Bundle

If I log an Activity and select the county it’s in and want to 
see the relationship with the other Activities in that county

I can query by county or view the county report
and get to all the Activities in that County

and thereby, I have no need to make a Bundle
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It might be that I logged two Activities:
A Section 7 and its associated Federal Activity 

Bundles
TAILS:  The Data Model

For each, I selected:
• The same County,
• The same Species,
• The same Staff

I could see their relationships in:

But

• The ‘Activities by County’ Report,
• A query on that Species,
• The ‘Activities by Staff’ Report
• Or even in combinations of these

• These Reports/Queries would include other Activities
• And I really need to understand that this one Activity

has a tight relationship with this one other Activity

So, I want to Bundle them.          It makes sense to me !
• And the data relationships alone are not sufficient enough



TAILS
Phase 5

T
A
I
L
S

racking

ntegrated

ogging

ystem

nd

8

Bundle
Activity(ies) Event(s)

Bundles and Events* are not required

Activity

Field Office A

Field Office B

Use of Bundles/Events need not be consistent within ESFO

Bundle
Activity(ies) Event(s)

Activity Field Office C

Logs Activities, and always
Associates Events to Activities
Associates Activities to Bundle

Logs Activities
and sometimes

Associates Events to Activities
and/or

Associates Activities to Bundles

Logs Activities

* See how to Log Fed Activities

Logging degree of detail (options)
TAILS:  The Data Model
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♦An Event, if defined, can associate with one or many Activities.
♦Bundles can be defined & associated before or after Activities
♦Bundles can be defined without associating Activities

♦An Activity may associate to many Bundles simultaneously

♦Associations can be changed/broken, with/out deleting Bundles 

Oops
Oops

♦Bundles can have Events without associating Activities

Flexibility
TAILS:  The Data Model
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May be used to Bundle Bundles (and all they contain)

SuperBundle
TAILS:  The Data Model

TAILS Bundle Code: 21420-2001-B-003
Bundle Title:  Barker Dam
Bundle Description: Reconstruction of hydro dam at Barker Reservoir.

(Section 7 Consultation: 21420-2001-F-0133)

(Section 7 Consultation: 21420-2002-F-0065)

(Federal Activity: 21420-2001-FA-0007) Events
Activities

TAILS Bundle Code: 21420-2005-B-056
Bundle Title:  Barker Bridge
Bundle Description: Bridge Construction over lower Barker River near Dam

(Section 7 Consultation: 21420-2003-F-0782)

(Contaminant Activity: 21420-2005-EC-0211)
Events

Activities

TAILS SuperBundle Code: 21420-2005-SB-001
SuperBundle Title:  Barker Dam and Bridge
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TAILS

SuperUsers
and

Customization
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♦ Each Field Office must designate at least one SuperUser
to set up the TAILS interface for their office. 

♦ SuperUsers need not be techo geeks, their job is 
accomplished through simple picklist selections via the 
internet.  They customize the interface and approve 
each Office user’s request for access to TAILS.

♦ SuperUsers must work closely with Field Staff, Project 
Leaders and Field Supervisors to define their office 
default values, the appropriate level of detail of 
information to be recorded (and it’s format) and which 
data fields will be 'required' or even 'visible' for their 
ESFO.  Primarily seen as an ‘initial’ setup.

Requirements and Responsibilities
SuperUsers
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♦ Customize the Interface to desires of their Office

♦ Approve Access Requests for their Office Staff

♦ Act as first line of Information Defense for their 
Users

♦ Direct their Users to other Help options

♦ Only ones in their Office that may Delete 
Activities, Bundles or SuperBundles

Roles
SuperUsers
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Customization by SuperUser

Lots of Customization and more coming
Each ESFO defines their interface
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Data Field default values may be pre-defined (e.g., 59 minutes)
Some default values can be overridden by data editors. (1 hr)

Customization by SuperUser

Default Settings
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♦ Data Field content ‘picklists’ may be pre-defined.

• The content of some data fields
will be controlled/limited through
the use of picklists or similar tools.

• Start from a National Master List

• Must be used to assure consistency                                      
of reporting.

• Some allow single selection only,                                    
some allow multiples.

• Can be enhanced/updated (Nationally)
after approval.

SuperUser defines
from Master

User selects from ESFO
defined subset of Master

Customization by SuperUser

Picklists
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To Add Staff, 
first Search 

ECOS 
Registered Users

View = ECOS Registered User.
So SuperUser can only ‘View’ 
that person’s registration info.

Edit = SuperUser entered info 
by hand and so can edit it.

If Staff Member is 
not an ECOS User,

SuperUser
fills in Staff 

Member 
information for

use in TAILS Staff 
Picklist

Customization by SuperUser

Staff List
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♦ Select State, then Counties
♦ Consider adjacent (impacted) Counties
♦ Selections also determine:

• Native Tribes List,
• USGS Quad List,
• Hydrologic Units List,
• Congressional District List,
• Refuge List

in your ESFO’s interface

Customization by SuperUser

County List Development and Use
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♦ Define your Species list from master list.
♦ Master list has

• Threatened
• Endangered
• Proposed
• Candidate

♦ You may suggest others (via ‘Contact Us’)
• State Species
• Species of Concern
• Others

♦ Once Species list is defined; create Groups

♦ Name the Group, and select from your list

♦ Suggestions:
• County-by-County (Smith County Species)
• Staff Groups (John’s Bird List)
• Watershed Groups (Lower X River Group)
• Ecosystem Groups (Karst Invertebrates)

Result:  Users can select (with a single click) a 
Species Group by name and get each species in 
that group to be in the ‘Species’ data field.

Customization by SuperUser

Species Lists and Species Groups
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♦ SuperUser must consult with Supervisors, Leads first
♦ Each Module has it’s own set of fields that can be set to:

Optional:  Retained in interface (available for data entry), or
Hidden:  Not portrayed in interface (not available), or
Required: Retained in interface (flagged with     and in *MRD)

♦ Settings can be changed but typically a one-time setup

MRD = Field will be 
listed in the

Missing Required Data 
Report if not completed

Customization by SuperUser

Fields included in your Interface

!
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♦ Each Module has a set – and they can’t be hidden
♦ Must be completed before the Activity Record is 
considered complete.

♦ NRFs are generally
determined by
Performance
Reporting or other
data call needs.

♦ Do NOT need to be completed in one data-entry session.
♦ ESFO can enhance and define additional required fields.
•8

♦ ESFO can hide non-required
data fields (but be careful).

Customization by SuperUser

Nationally Required Fields (NRFs)

!

!Indicated by
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♦ Some ‘Required’ Fields are Completed Automatically
• Office
• Fiscal Year (editable)
• Start Date (editable)
• Sequence Number (by FY, by Office, by Module)

♦ Some ‘Required’ Fields are really ‘Conditionally 
Required’

• Conclusion Date (if it’s been concluded)
• Final Decision Date (if Action Agency has made 
decision)

♦ No logic on front end for ‘Required’ – can use back 
data end logic via Reports 

♦ A ‘Missing Required Data’ Report is available. 

Customization by SuperUser

Nationally Required Fields (continued)
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Planned for future:  You define additional Spatial References

My Rivers
North Fork, Swift
South Form, Swift

Rocky River
Slow River

My Aquifers
Upper Texas Aquifer
Middle Texas Aquifer
Lower Texas Aquifer

Up to five

Customization by SuperUser

Location-specific Reference
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♦ Electronic Files may be Associated and Stored as; 
• Local files, or
• Uploaded to EDDL

Customization by SuperUser

ECOS Digital Document Library (EDDL)

♦ EDDL Serves as;
• Secure (& remote) backup devise for you
• Controlled (& remote) access for others you define 
• Efficient Record Development Option (for FOIAs,               
and Administrative Records)

♦ Available at
Activity-level
and
Event-level
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Works in combination with Default Hours
Is only applied with initial logging session

Footnote: see also, Species Name Display Style (wherever species is displayed)

Example: Default Hours set to 59 minutes, Technique = Cumulative Office

Total = 59 minutes

Example: Default Hours set to 59 minutes, Technique = Cumulative Employee

Total = 1 Hour: 58 minutes

Example: Default = 59 minutes, Technique = Cumulative Employee by Species

Total = 5 Hours: 54 minutes

Customization by SuperUser

Timekeeping Method
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♦ One Master Action/Work Type List
♦ SuperUsers customize by TAILS Module
♦ By subtracting / unchecking – by Module

All: (selections applied across all modules)
S7: Section 7 Consultation Activities
FA: Federal Activities (in 2010 = CPA)
EC: Environmental Contaminant Activities

or
B: Bundle

♦ SuperUsers may apply  ‘All’ partially
♦ Hierarchical reference must be maintained
Example: (you only want some AGRICULTURE)

Subtract AGRICULTURE  (uncheck)   
All ‘children’ get subtracted automatically
Checkmark indicates those you want

Parent

Grandparent

For this example, let’s say you really only want
AGRICULTURE - Grazing – Ongoing Activities – Hay (Check it) 

TAILS will automatically force any Parent (if it exists)
AGRICULTURE - Grazing – Ongoing Activities  (auto checked)

to be retained, as well as any Grandparent
AGRICULTURE (auto checked)

Necessary to maintain
organization and user
understanding
of hierarchy

Customization by SuperUser

Action / Work Type Customization
B
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♦ GPRA (PR) Indicator(s) shown in right column
♦ Every Action/Work Type is mapped to a GPRA category (some specific, some general)
♦‘FA’ or ‘S7’ shown only if NOT in the ‘catch all’ GPRA category for that Activity Type *
♦ No indicator means the Action/Work Type is in the ‘catch all’ (Other) GPRA category(ies)
♦ Pass cursor over Action/Work Type to see which GPRA categories it maps to

Pass your cursor over here

Shows this GPRA (PR) map

• FA = Federal Activities;
• S7 = Section 7 Activities;
• EC = Environmental Contaminants 
(coming soon)

*

Note specific
S7 category

And
S7 indicator

Customization by SuperUser

Action / Work Types & PR Category
B

GPRA: Government 
Performance and Results 
Act (more generic = 
Performance Reporting)
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Pass your cursor over here

Shows this GPRA map

♦ GPRA Indicator(s) shown in right column
♦ Every Action/Work Type is mapped to a GPRA category (some specific, some general)
♦‘FA’ or ‘S7’ shown only if NOT in the ‘catch all’ GPRA category for that Activity Type *
♦ No indicator means the Action/Work Type is in the ‘catch all’ (Other) GPRA category(ies)
♦ Pass cursor over Action/Work Type to see which GPRA categories it maps to

• FA = Federal Activities;
• S7 = Section 7 Activities;
• EC = Environmental Contaminants 
(coming soon)

*
Note ‘catch all’

S7 category

And no S7 indicator

Customization by SuperUser

Action / Work Types & GPRA Category
B
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SuperUsers and Approval of Users

User Access Levels
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TAILS

SuperUsers
and

Customization
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Understanding Queries 
 
 
 
 
Session Objectives:  At the conclusion of this session, you will be able to: 
 
 

 
 Explain and define Boolean operators. 
 
 Effectively perform a pre-logging search. 
 
 Perform an effective global search. 
 
 Choose the right search mechanism for the requirement. 
 
 Understand search and report results. 
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Important Note:  Once you log into TAILS, you will be able to navigate and use the 
system freely depending on your permissions.  You can even let TAILS sit idle and not 
need to log back into the system (so long as you keep Internet Explorer open and it sits 
idle for less than 3 hours).  But it is important to actually log out of TAILS when you are 
done for the day or when no additional access or editing is expected for some time.  
When you click on the  button (at the bottom of every TAILS page), it tells the 
ECOS server to disallow any further access to those pages until you've logged in again.  
Logging out will prevent any unauthorized access and generally assures better server 
processing and user access during your next session. 

 
Navigating the Search Page:  One general premise of TAILS is that, for fear of double 
logging and other purposes, users will prefer to search for existing Activities / Bundles 
before you are willing to enter a new Activity / Bundle.  As such, as you navigate 
between modules using the tabs, TAILS will take you, by default, to the search page for 
that module, so that you may search for existing Activities / Bundles. 

 
Each search page has three basic areas.  The search form itself, made up of a ‘Search 
Field’ picklist, an ‘Operator’picklist and a ‘Condition’ field, (top of main body), Recent 
Activities for that module (at the bottom), and ‘Start New’ and ‘Search’ links (in the left 
window pane). 

 

 
 

Figure 29.  Example search page. 
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Before entering any search criteria, you should review the ‘Recent Activities’ links at the 
bottom of the page.  This list provides the Activity Code and Title for the most-recently 
accessed Activities for that module.  The most-recently accessed Activity is listed first (at 
the top), followed by each of the next most-recently accessed Activity below that and so 
on.  Your Office defaults determine whether this list is shown on a ‘By Office’ basis 
(anyone in your office has accessed the Activity) or ‘User’ basis (the individual who 
accessed the Activity).  The number of Activities listed is also based on Office default 
settings and can be set as high as 25.  If any of these Recent Activities are the desired 
Activity, simply click on the Activity Code link to access the summary page for that 
Activity and then move on to edit specific information if desired.. 

 
 

THE SEARCH FORM:  To search for Activities that meet certain criteria, you’ll need 
to perform a search.  The TAILS search form has three elements: The search field list (on 
the left); the operator (in the center of the form); and the value/condition field (on the 
right). 

 

 
Figure 30.  TAILS Search Form 

 
To define the desired search criteria, select a data field (--Search Field--) to search within 
from the picklist provided.  Next, select an operation (e.g. "Equals" or "Before" or 
"After"), from the (--Operator--) picklist to use in conjunction with that Search Field.  
Lastly, type in a condition or value to search for that Search Field and Operator element 
set. 
 
Important Note:  In some cases, a single picklist selection for ‘--Search Field-- ‘ will 
actually search across multiple data fields.  For example, a selection of ‘Agency (Lead or 
Supporting)’ will actually impose the search criteria across both the ‘Lead Agency’ and 
‘Supporting Agencies’ data fields.  For a complete listing of these multi-field selections 
and the fields they are imposed on, refer to Appendix A. 
 
It’s important to know that the list of available search fields in the search form differs by 
module.  Additionally, the Operator picklist will adjust depending on the type of Search 
Field selected. 
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The Operator picklist is determined as follows: 
 

Search Field Class  Operator set 
Date Fields:  "Equals" or "Before" or "After" 

Numeric Fields:  "Equals" or "Greater Than" or "Less Than" 
Text Fields:  "Equals" or "Contains" or "Doesn’t Contain" 

 
Figure 31.  Search Form: Operator set for each Search Field Class 

 
PERFORMING A SEARCH:  To impose the criteria set and perform the search, click 
on the  button.  The results of the search (those Activities meeting the search 
criteria) will be shown at the bottom of the page, where the ‘Recent Activities’ list was 
originally displayed.  Search Results are displayed in ascending alphabetical order by 
Activity Code.  The Search mechanism and results appear similarly if you are searching 
for Bundles  
 
If you still don't see what you are looking for, you can modify your criteria and click 

 again. 
 
To search by more than one criterion, prior to clicking on the  button, click on 
the  button to get another full set of search elements.  You'll also need to select 
one of the Boolean connectors "AND" or "OR" to determine how the criterion from one 
search set will be combined with the other set(s). 
 

 
Figure 32.  Search Form:  Example showing search utilizing Boolean connectors. 

 
For a better understanding of the Boolean connectors, consider the following series of 
searches for Section 7 Consultation Activities: 
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First we search for Activities involving wolf species (we find three Activities) 
Query: (Species Contains "wolf") Reason for inclusion 
     Search Results  
22420-2006-I-0012: O Bar O Allotment Species contains “wolf” 
22420-2006-I-0013: Black Bob Allotment Species contains “wolf” 
22420-2006-I-0014: Apache Canyon Allotment Species contains “wolf” 

Figure 33a.  Example Search Series #1:  Results of “Species” contains “wolf”. 
 
In a new search, we search for Activities involving eagle (we find five Activities) 
Query: (Species Contains "eagle") Reason for inclusion 
     Search Results  
22420-2006-I-0006: Permeable Reactive Barriers within TA 16 LANL Species contains “eagle” 
22420-2006-SL-0007: Species List on SMA 47 acres near Aztec Species contains “eagle” 
22420-2006-F-0009: Bernalillo Priority Site Project Species contains “eagle” 
22420-2006-I-0013: Black Bob Allotment Species contains “eagle” 
22420-2006-I-0016: Simon Canyon Fisheries Species contains “eagle” 

Figure 33b.  Example Search Series #1:  Results of “Species” contains “eagle”. 
 
Next, we search for Activities where the species is either wolf or eagle using the "OR" 
Boolean connector (we get the same three wolf records found when we search only on 
wolf, plus the same five eagle records we got as a result of searching on only eagle, but 
since one record (22420-2006-I-0013: Black Bob Allotment) is actually in both the wolf 
set and the eagle set, we get a total of 7 records). 
Query: (Species Contains "wolf") OR (Species Contains "eagle") Reason(s) for inclusion 
     Search Results  
22420-2006-I-0006: Permeable Reactive Barriers within TA 16 LANL Species contains “eagle” 
22420-2006-SL-0007: Species List on SMA 47 acres near Aztec Species contains “eagle” 
22420-2006-F-0009: Bernalillo Priority Site Project Species contains “eagle” 
22420-2006-I-0012: O Bar O Allotment Species contains “wolf” 
22420-2006-I-0013: Black Bob Allotment 
 

Species contains “wolf” 
Species contains “eagle” 

22420-2006-I-0014: Apache Canyon Allotment Species contains “wolf” 
22420-2006-I-0016: Simon Canyon Fisheries Species contains “eagle” 

Figure 33c.  Example Search Series #1:  Results of “Species” contains “wolf” OR 
“Species” contains “eagle”. 
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As reinforcement that we have one record that actually meets both conditions, we search 
again using the "AND" Boolean connector and confirm that there is only one record 
where both wolf and eagle are listed in the ‘Species’ data field. 
Query: (Species Contains "wolf") AND (Species Contains "eagle") Reason(s) for inclusion 
     Search Results  

22420-2006-I-0013: Black Bob Allotment 
 

Species contains “wolf” 
AND 
Species contains “eagle” 

Figure 33d.  Example Search Series #1:  Results of “Species” contains “wolf” AND 
“Species” contains “eagle”. 

 

Important Note:  If you are mixing "AND" and "OR" connectors in the same search, the 
actual criteria you are setting up (and how the TAILS search engine will interpret it) may 
get confusing.  It is important to realize that the Boolean connector "AND" is always 
evaluated before "OR". 

Imagine we want to find those Activities that have “canyon” in the ‘Title or Description’ 
field and “wolf” or “eagle” in the ‘species’ field.  Consider the following example: 
 
First we search for Activities where “canyon” is included in the Activity Title or 
Description fields (we find three Activities) 
Query: (Title or Description Contains "canyon") Reason for inclusion 
     Search Results  
22420-2006-TA-0004: Frijoles Canyon Utility Improvement Project Title contains “canyon” 
22420-2006-I-0014: Apache Canyon Allotment Title contains “canyon” 
22420-2006-I-0016: Simon Canyon Fisheries Title contains “canyon” 

Figure 34a.  Example Search Series #2:  Results of “Title or Description” contains 
“canyon”. 

 
We add an "AND" condition for species containing “wolf” (only one record matches both 
those criteria). 
Query: (Title and Description Contains "canyon" AND Species 
Contains "wolf") 

 
Reason for inclusion 

     Search Results  

22420-2006-I-0014: Apache Canyon Allotment 
 

Title contains “canyon” 
AND 
Species contains “wolf” 

Figure 34b.  Example Search Series #2:  Results of “Title or Description” contains 
“canyon” AND “Species” contains “wolf”. 
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We continue building on the search by adding another Boolean connector, this time an 
"OR" condition on Species, such that the query looks like this: 
 

 
 

Figure 34c.  Example Search Series #2:  Search Form for “Title or Description” 
contains “canyon” AND “Species” contains “wolf” OR “Species” contains “eagle”. 

 
You might think that this search would be interpreted as the following 
 
Find all Activities where: 
 
 (Title /Description contains “canyon”) 
   AND 
 (Species contains either “wolf” OR “eagle”) 
 
But, as noted above, since the "AND" connector is always evaluated first (that is, it 
‘connects’ its search condition with that of the next [or prior] search condition), the 
search is actually interpreted as  
 
 (Title /Description contains “canyon” AND Species contains “wolf”) 

OR 
(Species contains “eagle”) 
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It should be understood that setting a ‘contains’ operator and entering a partial value for 
the condition, means you want that (partial) condition to be included in the results.  For 
example, if I enter ‘Staff’ contains “Alison”, my results will include everyone who is 
named Alison.  If I just enter ‘Staff’ contains “Al”, my results will include every Staff 
member who has the letters “al” in their name:  Alison Smith and also Carole Hale.  The 
search is case insensitive. 

 
Important Note:  The Search tool for TAILS Phase 1 is relatively simple, but it is 
powerful.  Users must be aware though of limitations as outlined above.  When you click 

, TAILS will echo back a parenthesized version of the criteria of that search to 
clarify how the selections made in the search form were actually evaluated and 
performed.  Make certain to review that search criteria statement before looking at the 
results themselves so that you fully understand the database query you imposed as well as 
the results.  Future phases of TAILS may utilize more complex (and difficult to use) 
search mechanism. 

Users are also directed to the pre-defined search results found through the ‘Reports’ 
module of TAILS as these may, effectively, provide much sought after search results and 
allow you to more easily and quickly locate and access the logged Activities you’re 
seeking. 
 
To reset the search form and begin a new search, click on the ‘Search’ link in the left 
window pane. 
 
Important Note:  To search across essentially no criteria and thereby bring up all the 
module-specific Activity (or Bundle) records for your Office, simply click on the 

 button without first selecting any search field, operator or condition. 
 
Assuming that you master the search tool, get the desired results, and discover that, 
indeed, the Activity was already logged, simply click on the Activity Code/Title link 
provided in the Search Results to jump directly to that Activity’s summary page and 
make any required edits or additions to the existing information. 
 
If, after thorough searching, you discover that the Activity warrants logging a new 
Activity, or you are confident that you need not search for existing Activities when 
entering a module, simply click on the ‘Start New’ link in the left window pane and start 
entering data for this new Activity or Bundle. 
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So, while you can see the results of 34f are different from those of 34d, neither gives a 
result that might be what we were really looking for. 
 
Lastly, consider this search and its result. 

 
 

Figure 34g.  Example Search Series #2:  Completed search form giving desired results 
 
So while it does take a little extra work (having to define the search criteria ‘canyon’ 
twice), the results are what we were after. 
 
((Title and Description Contains "canyon" AND Species Contains 
"wolf") OR (Title and Description Contains "canyon" AND Species 
Contains "eagle")) 

 
 
Reason(s) for inclusion 

     Search Results  

22420-2006-I-0014: Apache Canyon Allotment 
 

Title contains “canyon” 
AND 
Species contains “wolf” 

22420-2006-I-0016: Simon Canyon Fisheries 
 

Title contains “canyon” 
AND 
Species contains “eagle” 

 
Figure 34h.  Example Search Series #2:  Summary of desired results. 
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But, again, any search statements connected through an "AND" connector are evaluated 
first. 
 
So the actual results of the above evaluated search, would be as follows: 
 
 (Species contains “wolf”) 

OR 
(Species contains “eagle” AND Title /Description contains “canyon”) 

 
(Species Contains "wolf") OR (Species Contains "eagle" AND 
Title and Description Contains "canyon") 

 
Reason(s) for inclusion 

     Search Results  
22420-2006-I-0012: O Bar O Allotment Species contains “wolf” 
22420-2006-I-0013: Black Bob Allotment Species contains “wolf” 
22420-2006-I-0014: Apache Canyon Allotment Species contains “wolf” 

22420-2006-I-0016: Simon Canyon Fisheries 
 

Species contains “eagle” 
AND 
Title contains “canyon” 

Figure 34f.  Example Search Series #2:  Results of (Species Contains "wolf") OR 
(Species Contains "eagle" AND Title and Description Contains "canyon") 
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As such, the result of this search would be as follows: 
Query: (Title and Description Contains "canyon" AND Species 
Contains "wolf") OR (Species Contains "eagle") 

 
Reason(s) for inclusion 

     Search Results  
22420-2006-I-0006: Permeable Reactive Barriers within TA 16 LANL Species contains “eagle” 
22420-2006-SL-0007: Species List on SMA 47 acres near Aztec Species contains “eagle” 
22420-2006-F-0009: Bernalillo Priority Site Project Species contains “eagle” 
22420-2006-I-0013: Black Bob Allotment Species contains “eagle” 

22420-2006-I-0014: Apache Canyon Allotment 
 

Species contains “wolf” 
AND 
Title contains “canyon” 

22420-2006-I-0016: Simon Canyon Fisheries Species contains “eagle” 
Figure 34d.  Example Search Series #2:  Results of “Title or Description” contains 

“canyon” AND “Species” contains “wolf” OR “Species” contains “eagle”. 
 
You might hope that switching the order of the defined fields such that you define the 
Species set first then the Title criteria last (see below) might get you what you want. 
 

 
 

Figure 34e.  Example Search Series #2:  Search Form for “Species” contains “wolf” 
OR “Species” contains “eagle” AND “Title or Description” contains “canyon”. 

 
And, you would hope, the search would be interpreted as  
 
 (Species contains “wolf” OR Species contains “eagle”) 

AND 
(Title /Description contains “canyon”) 
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Office Reporting & PRS 
 
 
 
 
Session Objectives:  At the conclusion of this session, you will be able to: 
 
 

 
 Generate an Office Report with some customization. 
 
 Export any report to Excel, PDF, or other format. 
 
 Cite the relationship between TAILS and PRS 

 
 Explain how TAILS data is used for end-of-year 

performance reporting. 
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♦ Many more Office Reports (the simplest way to retrieve 
data for most common reporting needs)

♦ Expanded options for queries in Ad-Hoc Reports, 
including:
♦ ARRA Funding
♦ CBRIS 
♦ CBRA

♦ Easier-to-use output options in Ad-Hoc Reports
♦ New output formats

What’s new with TAILS reports?
Introduction to Reporting
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♦ Often referred to as “canned reports”
♦ Query can be modified to focus report
♦ Report itself is pre-formatted without options
♦ Wide variety of reports to meet most common reporting 

needs

1. Click Reports tab, then Office Reports link
2. Click on the desired report, for example:  Activities by Species
3. Use the Query Definition fields to refine the scope of the report.

♦ Don’t need to select anything
♦ The more selections, the fewer records returned and the more 

focused the report
4. Select the Output Format, and click the Go button.

Office Reports
Introduction to Reporting
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♦ HTML Table report most commonly 
used
♦ Can be exported to a variety of formats including Excel and 

PDF
♦ Links back to individual Activities are maintained
♦ Opens in a separate window; just close to return to TAILS 

Reports

♦ CSV (comma separated value) File
♦ Automatic for large reports (over 60,000 records)

♦ Summary Table
♦ Shows total # of records returned
♦ Compared to total # of unique Activities
♦ May be the same or quite different 

depending on query

Output Formats
Introduction to Reporting
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Working with CSV Output
Introduction to Reporting

After clicking the Go button, you get this 
message:

Click the Save button.
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Working with CSV Output
Introduction to Reporting

Browse to the correct location, then click the 
Save button.
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♦ Variety of popular formats
♦ CSV
♦ Excel
♦ PDF
♦ ArcMap (click on Map Results)

Exporting Reports
Introduction to Reporting
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♦ Logging Activities in TAILS required
♦ For CPA (formerly Federal Activities) 

since 2007 
♦ For Section 7 consultations since 2008 

♦ Accuracy and completeness essential
♦ FY for reporting purposes

♦ Endangered Species = September 1, 2008  
through August 31, 2009

♦ CPA (FA) = October 1, 2008 through 
September 30, 2009

♦ No adjustments for measures related to S7 
consultations EXCEPT in TAILS

EOY Reporting
Introduction to Reporting
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♦ Performance Reporting
♦ Preview Reports
♦ Transparency Reports
♦ A/W Types Mapping

♦ Retained in TAILS for reference 
♦ Replaced by Performance Reporting 

System (PRS) in ECOS

EOY Reporting
Introduction to Reporting
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♦ Secure ECOS homepage
♦ All EOY reporting in one place
♦ Review and check all year long
♦ Replaces GPRA and old TAILS reports
♦ Currently includes all Endangered Species 

and CPA measures
♦ More planned for 2010
♦ TAILS + other ECOS modules like TESS and ROAR
♦ Some data entered directly

♦ Transfer to Enterprise Planner (EP)
♦ Target setting planned for 2010

Performance Reporting System (PRS)
EOY Reporting
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After logging into secure ECOS, a customized 
version of PRS based on your office is 
available on the homepage.

Performance Reporting System (PRS)
EOY Reporting
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The first time you use PRS, you set your 
preferences for which measures to display.

Performance Reporting System (PRS)
EOY Reporting
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In the future, you can change these preferences 
easily by clicking the Choose link under the 
Program title in the report.

Performance Reporting System (PRS)
EOY Reporting
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♦ Current ECOS Value 
♦ Accurate as of today’s date
♦ Linked to constituent elements

Performance Reporting System (PRS)
EOY Reporting

♦ Click View to go to each Activity 
♦ May edit if TAILS user with edit access
♦ Anyone can view
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♦ Three levels of reports
♦ National
♦ Regional
♦ Field Office

♦ FO reported values “roll up” to 
Region, then “roll up” to National

♦ Adjustments allowed in FY08
♦ Reporting deadline to EP = early Sept
♦ Need to estimate until end of FY

♦ No adjustments allowed for ES measures for 
FY09

♦ Check your office’s values in PRS throughout 
the year

Performance Reporting System (PRS)
EOY Reporting
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Advanced Reporting 
 
 
 
 
Session Objectives:  At the conclusion of this session, you will be able to: 
 
 

 
 Identify the different types of reports in TAILS 
 
 Generate an Ad-hoc report in TAILS 

 
 Generate a Geographic Report 

 
 Generate Performance Reports 

 
⁻ Environmental Contaminants  
⁻ Section 7 Consultations  
⁻ Conservation Planning Assistance  

 
 Understand how to use the “Missing Required Data” and 

other Validation Reports 
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♦ More flexible but also more complex than Office 
Reports

♦ Many options
♦ Query can be modified to focus report
♦ Can specify information to appear on the report
♦ Some formatting options for the report are available

♦ Activity Report most versatile
♦ Specialized Ad-Hoc reports

♦ Sikes Act Report
♦ Administrative Record Report

♦ Aids in the development of an admin record
♦ Zip-and-ship function in development

Ad-Hoc Reports
Advanced Reporting
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Build a basic ad-hoc report like this:
1. Click Reports tab, then Ad-Hoc Reports link
2. Click on the desired report, for example:  Activities Report
3. Use the Query Definition fields to refine the scope of the 

report.
♦ Don’t need to select anything
♦ The more selections, the fewer records returned and the 

more focused the report
♦ Take your time – there are a lot of options!

4. Select Display Options  – one or more groups of fields to be 
included in your report.

5. Select Sort options – how should your report be organized?
6. Select the Output Format, and click the Go button.

Ad-Hoc Reports
Advanced Reporting
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♦ Reports on Activities by geographic location
♦ Congressional District
♦ County
♦ EcoRegion
♦ State
♦ USGS Quad
♦ Watershed

♦ NEW! Within Coastal Zone and Within 
Flood Plain report

♦ Download a shapefile of office Activities
♦ Geographic location must be defined to 

appear on report

Geographic Reports
Advanced Reporting
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♦ Look for and fix problems with office data
♦ Missing required info

♦ Nationally required fields
♦ Locally required fields 

♦ Chronology errors
♦ Example: Start Date after Conclusion Date

♦ Specialized reports
♦ No Service Work Performed

♦ When at least one Event is logged

♦ Activities with Fiscal Year Discrepancy
♦ Start Date doesn’t match FY

♦ Accuracy and completeness essential for 
EOY performance reporting

Validation Reports
Advanced Reporting
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♦ Administrative Reports
♦ Get a report of SuperUsers by Region

♦ National Required Fields
♦ See which fields need to be completed by 

the end of the FY to ensure accurate 
performance reporting

♦ Picklist Reports
♦ The contents of all picklists in a handy 

printable format

Other Useful Reports
Advanced Reporting
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♦ Third party software (JasperSoft) integrated 
into ECOS (and TAILS)

♦ New technology
♦ Need to transfer existing reports
♦ Some training will be needed

♦ Makes access to data easier, less frustrating
♦ Standardize reporting throughout ECOS
♦ “Canned” reports easier to create
♦ Ad-Hoc capability more powerful

♦ Every field available for query and output

Demo JasperSoft Reporting

Jasper Reports
Advanced Reporting

http://www.jaspersoft.com/demos/jbis30_adhoc_query_report_user/index.html�
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♦ Three tiers of reports
♦ “Canned” reports 

♦ Created by developers for each application
♦ Easy-to-use environment

♦ User-created reports based on existing 
“canned” report structure
♦ More flexibility

♦ User-created ad-hoc reports
♦ All fields included

♦ Users create their own reports and save them 
to use again

♦ Reports are interactive – update when data 
changes

Jasper Reports
Advanced Reporting
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TAILS

2013 Performance Reporting

Section 7 Consultation
Activities
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End-of-Year Performance Measures
2013 Performance Reporting:  Section 7 Consultations

 Devised in 1993 and Requires that Agencies:
• Develop Strategic Plans describing their overall goals/objectives
• Annual Performance Plans w/ quantifiable measures of progress
• Performance Reports describing success in meetings standards 

and measures

 Built from FWS Operational Plan & DOI Strategic Plan
• Includes Government Performance and Results Act (GPRA)
• Program Performance Assessment Rating Tool (PART)
• And more (e.g., American Recovery and Reinvestment Act ?)

 Each Program reports on several metrics
• How Many Activities …
• Which percentage of …

 Some Measures in Manager’s / Your Performance Plans
 Plans / Performance Reports shared with Congress

• To assist with funding issues / decisions
• To improve performance and efficiencies
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Section 7 Performance Reporting Basics

 Formal vs Informal ?

 Hydro, Non-Hydro Energy, Water, Forest, Forage, Non-Energy Minerals, Others ?

 This Reporting Year, how many of each of the above were
– Provided ?,
– Initiated ?, 
– Completed ?,
– Completed in a timely manner ?

 Had Jeopardy and/or Adverse Modification BCs ?

 Had Jeopardy /Adverse Modification Without RPAs ? 

RPA: Reasonable and Prudent AlternativesBC: Biological Conclusion

Measures have been greatly simplified since 2008:

* Formals only

*

*

2013 Performance Reporting:  Section 7 Consultations

2008 and prior years
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Section 7 Performance Reporting Basics

 Formal vs Informal ?

 Hydro, Non-Hydro Energy, Water, Forest, Forage, Non-Energy Minerals, Others ?

 This Reporting Year, how many of each of the above were
– Provided ?,
– Initiated ?, 
– Completed ?,
– Completed in a timely manner ?

 Had Jeopardy and/or Adverse Modification BCs ?

 Had Jeopardy /Adverse Modification Without RPAs ? 

RPA: Reasonable and Prudent AlternativesBC: Biological Conclusion

Measures have been greatly simplified since 2008:

* Formals only

*

*

2013 Performance Reporting:  Section 7 Consultations

2009 - 2013
Formals OR Informals

Only what you Completed



Mark Jacobsen (505) 248-6662

Jason Duke (931) 525-4986 3

TAILS

T
A
I
L
S

racking

ntegrated

ogging

ystem

nd

5

Section 7 Performance Reporting Basics

 Formal vs Informal ?

 Hydro, Non-Hydro Energy, Water, Forest, Forage, Non-Energy Minerals, Others ?

 This Reporting Year, how many of each of the above were
– Provided ?,
– Initiated ?, 
– Completed ?,
– Completed in a timely manner ?

 Had Jeopardy and/or Adverse Modification BCs ?

 Had Jeopardy /Adverse Modification Without RPAs ?

RPA: Reasonable and Prudent AlternativesBC: Biological Conclusion

Measures have been greatly simplified since 2008:

* Formals only

*

*

2013 Performance Reporting:  Section 7 Consultations

2009 - 2013
Formals OR Informals

Only what you Completed

Due to other data calls, each type still matters, continue to log all types.

Due to other data calls, these are still reported on.

Due to numerous FOIAs and your own needs, continue to record BCs

Still counted in EOY reporting, keep selecting all that apply.
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In TAILS,

TAILS Bundle Code: 21420-2009-B-003
Bundle Title:  Barker Dam
Bundle Description: Reconstruction of hydro dam at Barker Reservoir.

(Section 7 Consultation: 21420-2009-F-0133)

(Section 7 Consultation: 21420-2010-F-0065)

(CPA Activity: 21420-2010-CPA-0007) Events
Activities

TAILS Bundle Code: 21420-2010-B-056
Bundle Title:  Barker Bridge
Bundle Description: Bridge Construction over lower Barker River near Dam

(Section 7 Consultation: 21420-2010-F-0782)

(Contaminant Activity: 21420-2009-EC-0211)
Events

Activities

TAILS SuperBundle Code: 21420-2009-SB-001
SuperBundle Title:  Barker Dam and Bridge

you may Log ‘Activities’, add specific details as ‘Events’ , associate
multiple Activities together into ‘Bundles’, put Bundles into‘SuperBundles’

2013 Performance Reporting:  Section 7 Consultations

Logging TAILS data for Section 7 
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7

Only Activities Count

TAILS Bundle Code: 21420-2009-B-003
Bundle Title:  Barker Dam
Bundle Description: Reconstruction of hydro dam at Barker Reservoir.

(Section 7 Consultation: 21420-2009-F-0133)

(Section 7 Consultation: 21420-2010-F-0065)

(CPA Activity: 21420-2010-CPA-0007) Events
Activities

TAILS Bundle Code: 21420-2010-B-056
Bundle Title:  Barker Bridge
Bundle Description: Bridge Construction over lower Barker River near Dam

(Section 7 Consultation: 21420-2010-F-0782)

(Contaminant Activity: 21420-2005-EC-0211)
Events

Activities

TAILS SuperBundle Code: 21420-2009-SB-001
SuperBundle Title:  Barker Dam and Bridge

• SuperBundles DON’T Count

2013 Performance Reporting:  Section 7 Consultations
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Only Activities Count

TAILS Bundle Code: 21420-2009-B-003
Bundle Title:  Barker Dam
Bundle Description: Reconstruction of hydro dam at Barker Reservoir.

(Section 7 Consultation: 21420-2009-F-0133)

(Section 7 Consultation: 21420-2010-F-0065)

(CPA Activity: 21420-2010-CPA-0007) Events
Activities

TAILS Bundle Code: 21420-2010-B-056
Bundle Title:  Barker Bridge
Bundle Description: Bridge Construction over lower Barker River near Dam

(Section 7 Consultation: 21420-2010-F-0782)

(Contaminant Activity: 21420-2005-EC-0211)
Events

Activities

• SuperBundles DON’T Count
• Bundles DON’T Count

2013 Performance Reporting:  Section 7 Consultations
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Only Activities Count

(Section 7 Consultation: 21420-2009-F-0133)

(Section 7 Consultation: 21420-2010-F-0065)

(CPA Activity: 21420-2010-CPA-0007) Events
Activities

(Section 7 Consultation: 21420-2010-F-0782)

(Contaminant Activity: 21420-2005-EC-0211)
Events

Activities

• SuperBundles DON’T Count
• Bundles DON’T Count

2013 Performance Reporting:  Section 7 Consultations
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Only Activities Count

(Section 7 Consultation: 21420-2009-F-0133)

(Section 7 Consultation: 21420-2010-F-0065)

(CPA Activity: 21420-2010-CPA-0007) Events
Activities

(Section 7 Consultation: 21420-2010-F-0782)

(Contaminant Activity: 21420-2005-EC-0211)
Events

Activities

• SuperBundles DON’T Count
• Bundles DON’T Count
• Events DON’T Count

2013 Performance Reporting:  Section 7 Consultations
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Only Activities Count

(Section 7 Consultation: 21420-2009-F-0133)

(Section 7 Consultation: 21420-2010-F-0065)

(CPA Activity: 21420-2010-CPA-0007)
Activities

(Section 7 Consultation: 21420-2010-F-0782)

(Contaminant Activity: 21420-2005-EC-0211)
Activities

• SuperBundles DON’T Count
• Bundles DON’T Count
• Events DON’T Count

2013 Performance Reporting:  Section 7 Consultations

TAILS

T
A
I
L
S

racking

ntegrated

ogging

ystem

nd

What Counts in Section 7 Performance Reporting?

12

Only Activities Count

(Section 7 Consultation: 21420-2009-F-0133)

(Section 7 Consultation: 21420-2010-F-0065)

(CPA Activity: 21420-2010-CPA-0007)
Activities

(Section 7 Consultation: 21420-2010-F-0782)

(Contaminant Activity: 21420-2005-EC-0211)
Activities

• SuperBundles DON’T Count
• Bundles DON’T Count
• Events DON’T Count
• Non-Section 7s DON’T Count

2013 Performance Reporting:  Section 7 Consultations
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Only Activities Count

(Section 7 Consultation: 21420-2009-F-0133)

(Section 7 Consultation: 21420-2010-F-0065)

(Section 7 Consultation: 21420-2010-F-0782)

• SuperBundles DON’T Count
• Bundles DON’T Count
• Events DON’T Count
• Non-Section 7s DON’T Count

2013 Performance Reporting:  Section 7 Consultations
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Only Activities Count

(Section 7 Consultation: 21420-2009-F-0133)

(Section 7 Consultation: 21420-2010-F-0065)

(Section 7 Consultation: 21420-2010-F-0782)

• SuperBundles DON’T Count
• Bundles DON’T Count
• Events DON’T Count
• Non-Section 7s DON’T Count
• Only those concluded this RY* Count

2013 Performance Reporting:  Section 7 Consultations

* RY = Reporting Year.  2013 RY = 09/01/2012 through 08/31/2013
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What Counts in Section 7 Performance Reporting?

15

Only Activities Count

(Section 7 Consultation: 21420-2010-F-0782)

• SuperBundles DON’T Count
• Bundles DON’T Count
• Events DON’T Count
• Non-Section 7s DON’T Count
• Only those concluded this RY* Count

2013 Performance Reporting:  Section 7 Consultations

* RY = Reporting Year.  2013 RY = 09/01/2012 through 08/31/2013
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What Counts in Section 7 Performance Reporting?

16

Only Activities Count

(Section 7 Consultation: 21420-2010-F-0782)

• SuperBundles DON’T Count
• Bundles DON’T Count
• Events DON’T Count
• Non-Section 7s DON’T Count
• Only those concluded this RY* Count

• Those logged as the following DON’T Count
- No Further Service Work Performed:

Not necessary/appropriate, or
Lack of Service resources

2013 Performance Reporting:  Section 7 Consultations

* RY = Reporting Year.  2013 RY = 09/01/2012 through 08/31/2013
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• Those ‘Withdrawn’ DO Count

• Measures are broken into various PR categories

What Counts in Section 7 Performance Reporting?

17

Only Activities Count

(Section 7 Consultation: 21420-2010-F-0782)

• SuperBundles DON’T Count
• Bundles DON’T Count
• Events DON’T Count
• Non-Section 7s DON’T Count
• Only those concluded this RY* Count

• Those logged as the following DON’T Count
- No Further Service Work Performed:

Not necessary/appropriate, or
Lack of Service resources

2013 Performance Reporting:  Section 7 Consultations

* RY = Reporting Year.  2013 RY = 09/01/2012 through 08/31/2013
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 Formal OR Informal ?

 Performance Reporting Category ?

 Completed (and if so, was it ‘timely’) ?

2013 Performance Reporting:  Section 7 Consultations

What Counts in Section 7 Performance Reporting?

 Formal OR Informal ?

 Performance Reporting Category ?

 Completed (and if so, was it ‘timely’) ?

Consultation Type of:
• Formal Consultation,
• Formal Conference,
• Formal Emergency Consultation,
• Informal Consultation,
• Informal Conference,
• Informal Emergency Consultation
• COUNT in End-of-Year Performance Reporting

Consultation Type of:
Early, Technical Assistance (including Species Lists)
• No longer count in End-of-Year Performance Reporting
• But still used in other data calls, so log all Types
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 Formal OR Informal ?

 Performance Reporting Category ?

 Completed (and if so, was it ‘timely’) ?

2013 Performance Reporting:  Section 7 Consultations

What Counts in Section 7 Performance Reporting?

(Formal or Informal:  Consultation, Conference, Emergency)

TAILS
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ENERGY (broken down to:)
• ENERGY: Renewable
• ENERGY: Hydropower
• ENERGY: Non-Hydropower
(e.g., Mining of Energy Minerals,
Oil and Gas Exploration,
Non-Hydro Power Generation,
Transmission Line Work,
Dept of Energy Operations,
Other ENERGY-related work)

NON-ENERGY (broken down to:)
• Non-Energy Minerals (e.g., gold)
• Forage (e.g., grazing)
• Forest (e.g., harvest, restoration)
• Water (e.g., supply/delivery, dam)
• Other (e.g., agriculture, marina, 

levee, shoreline/beach protection,
stream/waterbody modification,
cell towers, telephone lines, roads,
bridges, military operations, etc)

2013 Performance Reporting:  Section 7 Consultations

 Formal OR Informal ?

 Performance Reporting Category ?

 Completed (and if so, was it ‘timely’) ?

(Formal or Informal:  Consultation, Conference, Emergency)
 Formal OR Informal ?

 Performance Reporting Category ?

 Completed (and if so, was it ‘timely’) ?

What Counts in Section 7 Performance Reporting?

In TAILS:
Action/Work Type determines if the Activity is either;
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 Formal OR Informal ?

 Performance Reporting Category ?

 Completed (and if so, was it ‘timely’) ?

21

Every Action/Work Type has a corresponding PR Category

If you select more than one Action/Work Type,
• They may all map out to the same PR Category

- The one Activity will be counted once
(in the one PR category it mapped to)

• They may map out to multiple PR Categories
- The one Activity will be counted once

(in each of the PR categories it mapped out to)

2013 Performance Reporting:  Section 7 Consultations

(Formal or Informal:  Consultation, Conference, Emergency)

In TAILS:
You can select more than one Action/Work Type

What Counts in Section 7 Performance Reporting?
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22

Power Generation - Hydropower
Power Generation - Hydropower - New License
Power Generation - Hydropower - New License - FERC
Power Generation - Hydropower - Post License
Power Generation - Hydropower - Post License - FERC
Power Generation - Hydropower - Preliminary Permit
Power Generation - Hydropower - Preliminary Permit - FERC
Power Generation - Hydropower - Relicense
Power Generation - Hydropower - Relicense - FERC
Power Generation - Hydropower - Other
Power Generation - Hydropower - Other - FERC

Sample of Action/Work Type - PR Category mapping

Each of these Action/Work Types maps out to:
PR Category (ENERGY:  Hydropower)

Action/Work Type (sample)

2013 Performance Reporting:  Section 7 Consultations
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Non-Energy Minerals
Mining - Subsurface Extraction - Non Energy Materials
Mining - Subsurface Exploration - Non Energy Materials
Mining - Subsurface Leasing - Non Energy Materials
Mining - Subsurface Reclamation - Non Energy Materials
Mining - Surface Extraction - Non Energy Materials
Mining - Surface Exploration - Non Energy Materials
Mining - Surface Leasing - Non Energy Materials
Mining - Surface Reclamation - Non Energy Materials

Each of these Action/Work Types maps out to:
PR Category (NON-ENERGY:  Non-Energy Minerals)

Action/Work Type (sample)

2013 Performance Reporting:  Section 7 Consultations

Sample of Action/Work Type - PR Category mapping
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Non-Energy Minerals
Mining - Subsurface Extraction - Non Energy Materials
Mining - Subsurface Exploration - Non Energy Materials
Mining - Subsurface Leasing - Non Energy Materials
Mining - Subsurface Reclamation - Non Energy Materials

If you logged an Activity with all these Action/Work Types

Power Generation – Hydropower
Power Generation - Hydropower - New License






It would count in PR as:
ENERGY: Hydropower (n=1)

and 
NON-ENERGY:  Non-Energy Minerals (n=1)

Each PR Category max n = 1:
No matter how many
Action/Work Types
mapped to that one

PR Category

2013 Performance Reporting:  Section 7 Consultations

Sample of Action/Work Type - PR Category mapping

Just an example
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 Formal OR Informal ?

 Performance Reporting Category ?

 Completed (and if so, was it ‘timely’) ?

2013 Performance Reporting:  Section 7 Consultations

What Counts in Section 7 Performance Reporting?

(Formal or Informal:  Consultation, Conference, Emergency)
 Formal OR Informal ?

 Performance Reporting Category ?

 Completed (and if so, was it ‘timely’) ?• ENERGY: Renewable (solar, geothermal, wind)
• ENERGY: Hydropower
• ENERGY: Non-Hydropower

• NON-ENERGY: Water
• NON-ENERGY: Forest
• NON-ENERGY: Forage
• NON-ENERGY: Non-Energy Minerals
• NON-ENERGY: Other

Renewable Energy is reported quarterly for DOI  & Non-DOI Agencies
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ystem

nd

 Formal OR Informal ?

 Performance Reporting Category ?

 Completed (and if so, was it ‘timely’) ?

26

2013 Performance Reporting:  Section 7 Consultations

What Counts in Section 7 Performance Reporting?

(Formal or Informal:  Consultation, Conference, Emergency)

(From Action/Work Type(s),  One Activity can count in >1 Category)
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 Formal OR Informal ?

 Performance Reporting Category ?

 Completed (and if so, was it ‘timely’) ?

2013 Performance Reporting:  Section 7 Consultations

What Counts in Section 7 Performance Reporting?

(Formal or Informal:  Consultation, Conference, Emergency)
 Formal OR Informal ?

 Performance Reporting Category ?

 Completed (and if so, was it ‘timely’) ?
(From Action/Work Type(s),  One Activity can count in >1 Category)

• Completed:  Your Conclusion Date is in Reporting Year
• Timely:  Your logged Due Date compared against

Your logged Conclusion Date
(Regardless of when the Consultation started)

• We DON’T compare Start Date and
Consultation Type

(e.g., was the Formal done 135 days from Start Date?)

• Log ‘Extension to Due Date Authorized/Accepted’ Event
if appropriate

2013 Reporting Year
09/01/2012 through 

08/31/2013
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 Formal OR Informal ?

 Performance Reporting Category ?

 Completed (and if so, was it ‘timely’) ?

28

2013 Performance Reporting:  Section 7 Consultations

What Counts in Section 7 Performance Reporting?

(Formal or Informal:  Consultation, Conference, Emergency)

(Your ‘Due Date’ vs ‘Conclusion Date’, Extension to Due Date Event)

(From Action/Work Type(s),  One Activity can count in >1 Category)

# Total Responses
• ENERGY: Renewable
• ENERGY: Hydropower
• ENERGY: Non-Hydro
• NON-ENERGY: Water
• NON-ENERGY: Forest
• NON-ENERGY: Forage
• NON-ENERGY: Minerals
• NON-ENERGY: Other

Of Total, # Timely Responses
• ENERGY: Renewable
• ENERGY: Hydropower
• ENERGY: Non-Hydro
• NON-ENERGY: Water
• NON-ENERGY: Forest
• NON-ENERGY: Forage
• NON-ENERGY: Minerals
• NON-ENERGY: Other
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Service Performance Reporting:  How it works

HabITS: Habitat Information Tracking System;  ROAR:  Recovery On-Line Activity Reporting;
TAILS:  Tracking and Integrated Logging System;  TESS: Threatened and Endangered Species System;

Measure
Rule / Logic 

Engine

Measure
Rule / Logic 

Engine

Measure
Rule / Logic 

Engine

ReportsReports
• ESFO Counts
• RO Rollup
• WO Rollup

• ESFO Counts
• RO Rollup
• WO Rollup

Reports
• ESFO Counts
• RO Rollup
• WO Rollup

TESSTESSTESS

ROARROARROAR

PTracPTrac
ReportingReporting

DOIDOI
PTrac

Reporting
DOI

• Data review throughout year
• Access to Rules / Logic
• Data ‘adjustment’ during

reporting window for some metrics

• Data entry and review throughout year 
• On-line aids to assure complete 

and accurate logging

For example: 14.1.2.1:
Timely Non-Hydro Energy
• Section 7,
• Formal / Informal,
• Non Hydro Energy,
• Completed this RY,
• Timely

• Data review during
EOY window only

HabITSHabITSHabITS

TAILSTAILSTAILS

Performance
Tracking 

System

ECOS - PRS: Performance Reporting System

2013 Performance Reporting:  Section 7 Consultations

29
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For example: 14.1.2.1:
Timely Non-Hydro Energy

Does this Activity fit ALL
Measure Rules ?

• Section 7 ?
• Formal / Informal ?
• Non Hydro Energy ?
• Completed this RY ?
• Timely ?

Service Performance Reporting: How it works

Yep:  count this one
as a Timely Non-Hydro 
Energy Section 7 credit 

for this year

 Yes, it’s a Section 7 Consultation

 Yes, it’s an Informal

 Yes, this falls into that bucket

 Yes
 Concluded before Due = Timely

2013 Performance Reporting:  Section 7 Consultations

Example is from prior RY

IMPORTANT
For Crediting in RY 2013
Conclusion Date must be

With Reporting Year range
09/01/2012  - 08/31/2013 30
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Service Performance Reporting ECOS Integration

Like I said last slide, 
Yep;

count this one

PRS Report
For example: 14.1.2.1:
Timely Non-Hydro Energy
• Section 7,
• Formal / Informal,
• Non Hydro Energy,
• Completed this RY,
• Timely

PRS allows 
you to view 

and, if 
appropriate, 
edit each of 

the Activities 
that made up 

each 
measure’s 

count

2013 Performance Reporting:  Section 7 Consultations
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3232

As of May 1, 2009

American Recovery and Reinvestment Act (ARRA) 
(funding source)
Must be logged

Although not in our Operational Plan
and thereby not part of Performance Reporting

It is a critical component to logging
Section 7 Consultation Activities

2013 Performance Reporting:  Section 7 Consultations
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Bottom Line

2013 Performance Reporting:  Section 7 Consultations

• Log what matters to your Office
• Log Nationally Required Fields

Especially:
Action/Work Type,

Lead Agency, 
Due Date,

Conclusion Date

and log in “No further Service work performed”
ONLY if you did NO work

• Check the Validation Reports in TAILS
• Review your counts, if desired, in PRS

• Don’t let a ‘count desire’ drive how you log !

Data Quality is EVERYONE’S Responsibility

33
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34

TAILS

2013 Performance Reporting

Section 7 Consultation
Activities
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TAILS

2013 Performance Reporting

Conservation Planning Assistance
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2

End-of-Year Performance Measures
2013 Performance Reporting:  Conservation Planning Assistance

 Devised in 1993 and Requires that Agencies:
• Develop Strategic Plans describing their overall goals/objectives
• Annual Performance Plans w/ quantifiable measures of progress
• Performance Reports describing success in meetings standards 

and measures

 Built from FWS Operational Plan & DOI Strategic Plan
• Includes Government Performance and Results Act (GPRA)
• Program Performance Assessment Rating Tool (PART)
• And more (e.g., American Recovery and Reinvestment Act ?)

 Each Program reports on several metrics
• How Many Activities …
• How Much Acreage …

 Some Measures in Manager’s / Your Performance Plans
 Plans / Performance Reports shared with Congress

• To assist with funding issues / decisions
• To improve performance and efficiencies
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Logging TAILS data for CPA 
In TAILS,

TAILS Bundle Code: 21420-2009-B-003
Bundle Title:  Barker Dam
Bundle Description: Reconstruction of hydro dam at Barker Reservoir.

(Section 7 Consultation: 21420-2009-F-0133)

(Section 7 Consultation: 21420-2010-F-0065)

(CPA Activity: 21420-2010-CPA-0007) Events
Activities

TAILS Bundle Code: 21420-2010-B-056
Bundle Title:  Barker Bridge
Bundle Description: Bridge Construction over lower Barker River near Dam

(Section 7 Consultation: 21420-2010-F-0782)

(CPA Activity: 21420-2010-CPA-0211)
Events

Activities

TAILS SuperBundle Code: 21420-2009-SB-001
SuperBundle Title:  Barker Dam and Bridge

you may Log ‘Activities’, add specific details as ‘Events’ , associate
multiple Activities together into ‘Bundles’, put Bundles into‘SuperBundles’

2013 Performance Reporting:  Conservation Planning Assistance
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What Counts in CPA Performance Reporting?

4

Only Activities and some Events Count

TAILS Bundle Code: 21420-2009-B-003
Bundle Title:  Barker Dam
Bundle Description: Reconstruction of hydro dam at Barker Reservoir.

(Section 7 Consultation: 21420-2009-F-0133)

(Section 7 Consultation: 21420-2010-F-0065)

(CPA Activity: 21420-2010-CPA-0007) Events
Activities

TAILS Bundle Code: 21420-2010-B-056
Bundle Title:  Barker Bridge
Bundle Description: Bridge Construction over lower Barker River near Dam

(Section 7 Consultation: 21420-2010-F-0782)

(CPA Activity: 21420-2010-CPA-0211)
Events

Activities

TAILS SuperBundle Code: 21420-2009-SB-001
SuperBundle Title:  Barker Dam and Bridge

• SuperBundles DON’T Count

2013 Performance Reporting:  Conservation Planning Assistance
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What Counts in CPA Performance Reporting?

5

Only Activities and some Events Count

TAILS Bundle Code: 21420-2009-B-003
Bundle Title:  Barker Dam
Bundle Description: Reconstruction of hydro dam at Barker Reservoir.

(Section 7 Consultation: 21420-2009-F-0133)

(Section 7 Consultation: 21420-2010-F-0065)

(CPA Activity: 21420-2010-CPA-0007) Events
Activities

TAILS Bundle Code: 21420-2010-B-056
Bundle Title:  Barker Bridge
Bundle Description: Bridge Construction over lower Barker River near Dam

(Section 7 Consultation: 21420-2010-F-0782)

(CPA Activity: 21420-2010-CPA-0211)
Events

Activities

• SuperBundles DON’T Count
• Bundles DON’T Count

2013 Performance Reporting:  Conservation Planning Assistance
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What Counts in CPA Performance Reporting?

6

Only Activities and some Events Count

(Section 7 Consultation: 21420-2009-F-0133)

(Section 7 Consultation: 21420-2010-F-0065)

(CPA Activity: 21420-2010-CPA-0007) Events
Activities

(Section 7 Consultation: 21420-2010-F-0782)

(CPA Activity: 21420-2010-CPA-0211)
Events

Activities

• SuperBundles DON’T Count
• Bundles DON’T Count

2013 Performance Reporting:  Conservation Planning Assistance
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What Counts in CPA Performance Reporting?

7

Only Activities and some Events Count

(Section 7 Consultation: 21420-2009-F-0133)

(Section 7 Consultation: 21420-2010-F-0065)

(CPA Activity: 21420-2010-CPA-0007) Events
Activities

(Section 7 Consultation: 21420-2010-F-0782)

(CPA Activity: 21420-2010-CPA-0211)
Events

Activities

• SuperBundles DON’T Count
• Bundles DON’T Count
• Non CPA (Federal Activities) DON’T Count

2013 Performance Reporting:  Conservation Planning Assistance
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What Counts in CPA Performance Reporting?

8

Only Activities and some Events Count

(CPA Activity: 21420-2010-CPA-0007) Events

(CPA Activity: 21420-2010-CPA-0211)
Events

• SuperBundles DON’T Count
• Bundles DON’T Count
• Non CPA (Federal Activities) DON’T Count

2013 Performance Reporting:  Conservation Planning Assistance
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What Counts in CPA Performance Reporting?

9

Only Activities and some Events Count

(CPA Activity: 21420-2010-CPA-0007) Events

(CPA Activity: 21420-2010-CPA-0211)
Events

• SuperBundles DON’T Count
• Bundles DON’T Count
• Non CPA (Federal Activities) DON’T Count
• Events DON’T Count (unless ‘Count in PR’     ed)

2013 Performance Reporting:  Conservation Planning Assistance
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What Counts in CPA Performance Reporting?

10

2013 Performance Reporting:  Conservation Planning Assistance

Only Activities and some Events Count

(CPA Activity: 21420-2010-CPA-0007)

(CPA Activity: 21420-2010-CPA-0211)

• SuperBundles DON’T Count
• Bundles DON’T Count
• Non CPA (Federal Activities) DON’T Count
• Events DON’T Count (unless ‘Count in PR’     ed)
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What Counts in CPA Performance Reporting?

11

2013 Performance Reporting:  Conservation Planning Assistance

Only Activities and some Events Count

(CPA Activity: 21420-2010-CPA-0007)

(CPA Activity: 21420-2010-CPA-0211)

• SuperBundles DON’T Count
• Bundles DON’T Count
• Non CPA (Federal Activities) DON’T Count
• Events DON’T Count (unless ‘Count in PR’     ed)

‘PR unworthy’ Events may be logged
• Are good for Administrative Record
• Are not substantive enough to be ‘PR worthy’

(e.g., clarifying conversations, change meeting date)
• Logger leaves ‘Count as PR’ unchecked
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What Counts in CPA Performance Reporting?

12

2013 Performance Reporting:  Conservation Planning Assistance

Only Activities and some Events Count

(CPA Activity: 21420-2010-CPA-0007)

(CPA Activity: 21420-2010-CPA-0211)

• SuperBundles DON’T Count
• Bundles DON’T Count
• Non CPA (Federal Activities) DON’T Count
• Events DON’T Count (unless ‘Count in PR’     ed)



Mark Jacobsen (505) 248-6662

Jason Duke (931) 525-4986 7

TAILS

T
A
I
L
S

racking

ntegrated

ogging

ystem

nd

What Counts in CPA Performance Reporting?

13

2013 Performance Reporting:  Conservation Planning Assistance

Only Activities and some Events Count

(CPA Activity: 21420-2010-CPA-0007)

(CPA Activity: 21420-2010-CPA-0211)

• SuperBundles DON’T Count
• Bundles DON’T Count
• Non CPA (Federal Activities) DON’T Count
• Events DON’T Count (unless ‘Count in PR’     ed)
• Habitat-measures DON’T Count until FDDRY

• FDDRY = Final (Action Agency) Decision Date Reporting Year
• Habitat-measures logged as Compensatory Mitigation or Non- Comp.

(e.g., In-stream Miles, Wetland Acres, Upland Acres, Shoreline Miles)
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What Counts in CPA Performance Reporting?

14

2013 Performance Reporting:  Conservation Planning Assistance

Only Activities and some Events Count

(CPA Activity: 21420-2010-CPA-0007)

(CPA Activity: 21420-2010-CPA-0211)

• SuperBundles DON’T Count
• Bundles DON’T Count
• Non CPA (Federal Activities) DON’T Count
• Events DON’T Count (unless ‘Count in PR’     ed)
• Habitat-measures DON’T Count until FDDRY

• FDDRY = Final (Action Agency) Decision Date Reporting Year
• Species-measures may be logged on the ‘Details’ page of Activities

(‘Sect 18’ & ‘other’ miles of stream/shoreline reopened to fish passage)

• Species-measures DON’T Count until FDDRY

Section 18 of the Federal Power Act
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What Counts in CPA Performance Reporting?

15

2013 Performance Reporting:  Conservation Planning Assistance

Only Activities and some Events Count

(CPA Activity: 21420-2010-CPA-0007)

(CPA Activity: 21420-2010-CPA-0211)

• SuperBundles DON’T Count
• Bundles DON’T Count
• Non CPA (Federal Activities) DON’T Count
• Events DON’T Count (unless ‘Count in PR’     ed)
• Habitat-measures DON’T Count until FDDRY
• Species-measures DON’T Count until FDDRY

• Those Activities not started, concluded or worked on by the
Service during the reporting year DON’T Count (as ‘reviewed’)

• Those logged as ‘No Further Service Work Performed’
or as ‘No Comment’ under FWS Position, DON’T Count
(as Activity-level ‘reviewed’, nor as a TA Response*)

• Not ‘Worked on’ or Finalized; DON’T Count

* But you will still get credit for a ‘TA Request’
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What Counts in CPA Performance Reporting?
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2013 Performance Reporting:  Conservation Planning Assistance

Only Activities and some Events Count

(CPA Activity: 21420-2010-CPA-0007)

• SuperBundles DON’T Count
• Bundles DON’T Count
• Non CPA (Federal Activities) DON’T Count
• Events DON’T Count (unless ‘Count in PR’     ed)
• Habitat-measures DON’T Count until FDDRY
• Species-measures DON’T Count until FDDRY

• Those Activities not started, concluded or worked on by the
Service during the reporting year DON’T Count (as ‘reviewed’)

• Those logged as ‘No Further Service Work Performed’
or as ‘No Comment’ under FWS Position, DON’T Count
(as Activity-level ‘reviewed’, nor as a TA Response)

• Not ‘Worked on’ or Finalized; DON’T Count

• To get ‘Reviewed’ credit in a Subsequent Year
Log a ‘Count in PR’ Event and/or log Office/Staff Hours in FY
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2013 Performance Reporting:  Conservation Planning Assistance

CPA reports out on 5 measure categories

• Projects: (TAILS Activities)

• Technical Assistance: (TAILS Events)

• Habitat-related Measures: (TAILS Activity Details Page)

• Species-related Measures: (TAILS Activity Details Page)

• Scale / Level of Approach: (TAILS Activity)
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2013 Performance Reporting:  Conservation Planning Assistance

CPA reports out on 5 measure categories

• Projects: (TAILS Activities)

• Technical Assistance: (TAILS Events)

• Habitat-related Measures: (TAILS Activity Details Page)

• Species-related Measures: (TAILS Activity Details Page)

• Scale / Level of Approach: (TAILS Activity)
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2013 Performance Reporting:  Conservation Planning Assistance

CPA reports out on 5 measure categories

• Projects: (TAILS Activities)
# Reviewed Any CPA (Federal Activity) with Start or Response Date in 
the current RY, or with an Event in the current RY, or with hours logged 
for the current RY. No Activity which has one of the "No further Service 
work performed" or “No Comment” is ever included in this measure. 

# Reviewed Early in Planning Phase Any CPA (Federal Activity) counted 
as "Reviewed" above which also has Early Planning checked "Yes". 

• Energy (Non Hydropower)
• Hydropower (FERC license)
• Hydropower (FERC relicense)
• Hydropower (Other)
• Renewable Energy (Solar, Geothermal, Wind)
• Transportation
• Water Supply/Delivery
• Other

Each under these subcategories

Determined by your selection 
of Primary Action/Work Type

1oAction/Work Type 
and Lead Agency

MUST be selected for 
ANY CPA crediting

For DOI & Non-DOI
Agencies

2013 RY (Reporting Year) 
09/01/2012 through 08/31/2013
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2013 Performance Reporting:  Conservation Planning Assistance

CPA reports out on 5 measure categories

• Projects: (TAILS Activities)• Projects: (TAILS Activities)

• Technical Assistance: (TAILS Events)

• Habitat-related Measures: (TAILS Activity Details Page)

• Species-related Measures: (TAILS Activity Details Page)

• Scale / Level of Approach: (TAILS Activity)

• Projects: (TAILS Activities)

• Technical Assistance: (TAILS Events)

• Habitat-related Measures: (TAILS Activity Details Page)

• Species-related Measures: (TAILS Activity Details Page)

• Scale / Level of Approach: (TAILS Activity)

(Reviewed, Reviewed Early, Derived from 1oA/W T & Agency)
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2013 Performance Reporting:  Conservation Planning Assistance

CPA reports out on 5 measure categories

• Projects: (TAILS Activities)• Projects: (TAILS Activities)

• Technical Assistance: (TAILS Events)

• Projects: (TAILS Activities)

• Technical Assistance: (TAILS Events)

(Reviewed, Reviewed Early, Derived from 1oA/W T & Agency)
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2013 Performance Reporting:  Conservation Planning Assistance

CPA reports out on 5 measure categories

• Projects: (TAILS Activities)• Projects: (TAILS Activities)

• Technical Assistance: (TAILS Events)

# of Technical Assistance Requests Received
Any Request Event which has "Count in Performance Reporting" 
checked "Yes" counts for 1.  In addition, any CPA (Federal Activity) 
which has no associated Request Events counts for 1 if Activity-level 
Start (Received) Date is in the current RY. 

# of Technical Assistance Requests Completed 
Any Response Event which has "Count in Performance Reporting" 
checked "Yes" counts for 1.  In addition, any CPA (Federal Activity) 
which has no associated Response Events counts for 1 if Activity-
level FWS Response/Conclusion Date is in the current RY.  
For Activities which have a “FWS Position” of "No Comment" or one of the "No 
further Service work performed" options selected, no ‘completed’ credit is given.

(Reviewed, Reviewed Early, Derived from 1oA/W T & Agency)
1oAction/Work Type and 

Lead Agency
MUST be selected for ANY

CPA crediting

2013 RY (Reporting Year) 
09/01/2012 - 08/31/2013
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• Projects: (TAILS Activities)

• Technical Assistance: (TAILS Events)

• Projects: (TAILS Activities)

• Technical Assistance: (TAILS Events)

• Habitat-related Measures: (TAILS Activity Details Page)

• Species-related Measures: (TAILS Activity Details Page)

• Scale / Level of Approach: (TAILS Activity)

2013 Performance Reporting:  Conservation Planning Assistance

CPA reports out on 5 measure categories

• Projects: (TAILS Activities)• Projects: (TAILS Activities)

• Technical Assistance: (TAILS Events)

• Habitat-related Measures: (TAILS Activity Details Page)

• Species-related Measures: (TAILS Activity Details Page)

• Scale / Level of Approach: (TAILS Activity)

(TA Requests, TA Response, Derived from Event Type & PR )

(Reviewed, Reviewed Early, Derived from 1oA/W T & Agency)
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• Projects: (TAILS Activities)

• Technical Assistance: (TAILS Events)

2013 Performance Reporting:  Conservation Planning Assistance

CPA reports out on 5 measure categories

• Projects: (TAILS Activities)• Projects: (TAILS Activities)

• Technical Assistance: (TAILS Events)

• Habitat-related Measures: (TAILS Activity Details Page)

(TA Requests, TA Response, Derived from Event Type & PR )

(Reviewed, Reviewed Early, Derived from 1oA/W T & Agency)
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2013 Performance Reporting:  Conservation Planning Assistance

Data entered on the ‘Compensatory Mitigation’ Page 
feeds this part of the creditable ‘Total’ value

From Details Page showing Habitat Summary

Direct 
hand-entry
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2013 Performance Reporting:  Conservation Planning Assistance

• Habitat-related Measures: (TAILS Activity Details Page)

“Restored measures” must have a “Restored” 1˚A/W T
3.1.13:  # of non-FWS riparian (stream/shoreline) miles restored/enhanced through CPA
4.1.8:  # of non-FWS wetland acres restored/enhanced through CPA
4.2.9:  # of non-FWS upland acres restored/enhanced through CPA
4.3.4:  # of non-FWS coastal/marine acres restored/enhanced through CPA

“Restored” Primary Action/Work Types:
• LAND - RESTORATION / ENHANCEMENT
• Land Restoration / Enhancement - Agricultural
• Land Restoration / Enhancement - Forest
• Land Restoration / Enhancement - Grassland
• Land Restoration / Enhancement - Upland
• Land Restoration / Enhancement - Wetland
• Land Restoration / Enhancement - Other
• Stream Restoration / Enhancement
• Stream/Waterbody - Modification - Restoration / Enhancement
• Waterbody Restoration / Enhancement
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• Projects: (TAILS Activities)

• Technical Assistance: (TAILS Events)

2013 Performance Reporting:  Conservation Planning Assistance

CPA reports out on 5 measure categories

• Projects: (TAILS Activities)• Projects: (TAILS Activities)

• Technical Assistance: (TAILS Events)

• Habitat-related Measures: (TAILS Activity Details Page)

• Projects: (TAILS Activities)

• Technical Assistance: (TAILS Events)

• Habitat-related Measures: (TAILS Activity Details Page)

• Species-related Measures: (TAILS Activity Details Page)

• Projects: (TAILS Activities)

• Technical Assistance: (TAILS Events)

• Habitat-related Measures: (TAILS Activity Details Page)

• Species-related Measures: (TAILS Activity Details Page)

(Reviewed, Reviewed Early, Derived from 1oA/W T & Agency)

(TA Requests, TA Response, Derived from Event Type & PR )

(Wetland Acres, Shoreline Miles, In-Stream Miles, etc.)
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• Projects: (TAILS Activities)

• Technical Assistance: (TAILS Events)

2013 Performance Reporting:  Conservation Planning Assistance

CPA reports out on 5 measure categories

• Projects: (TAILS Activities)• Projects: (TAILS Activities)

• Technical Assistance: (TAILS Events)

• Habitat-related Measures: (TAILS Activity Details Page)

• Projects: (TAILS Activities)

• Technical Assistance: (TAILS Events)

• Habitat-related Measures: (TAILS Activity Details Page)

• Species-related Measures: (TAILS Activity Details Page)

• Projects: (TAILS Activities)

• Technical Assistance: (TAILS Events)

• Habitat-related Measures: (TAILS Activity Details Page)

• Species-related Measures: (TAILS Activity Details Page)
(Sect. 18 & other stream/shore miles reopened to fish passages)

(Reviewed, Reviewed Early, Derived from 1oA/W T & Agency)

(TA Requests, TA Response, Derived from Event Type & PR )

(Wetland Acres, Shoreline Miles, In-Stream Miles, etc.)
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• Projects: (TAILS Activities)

• Technical Assistance: (TAILS Events)

• Habitat-related Measures: (TAILS Activity Details Page)

• Species-related Measures: (TAILS Activity Details Page)

• Scale / Level of Approach: (TAILS Activity)

What Counts in CPA Performance Reporting?

29

2013 Performance Reporting:  Conservation Planning Assistance

CPA reports out on 5 measure categories

(Sect. 18 & other stream/shore miles reopened to fish passages)

(Reviewed, Reviewed Early, Derived from 1oA/W T & Agency)

(TA Requests, TA Response, Derived from Event Type & PR )

(Wetland Acres, Shoreline Miles, In-Stream Miles, etc.)

• Projects: (TAILS Activities)

• Technical Assistance: (TAILS Events)

• Habitat-related Measures: (TAILS Activity Details Page)

• Species-related Measures: (TAILS Activity Details Page)

• Scale / Level of Approach: (TAILS Activity)
• Typically complex / multi-year efforts
• Large-scale (landscape) or Programmatic measures
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• Projects: (TAILS Activities)

• Technical Assistance: (TAILS Events)

• Habitat-related Measures: (TAILS Activity Details Page)

• Species-related Measures: (TAILS Activity Details Page)

• Scale / Level of Approach: (TAILS Activity)

• Projects: (TAILS Activities)

• Technical Assistance: (TAILS Events)

• Habitat-related Measures: (TAILS Activity Details Page)

• Species-related Measures: (TAILS Activity Details Page)

• Scale / Level of Approach: (TAILS Activity)

• Projects: (TAILS Activities)

• Technical Assistance: (TAILS Events)

• Habitat-related Measures: (TAILS Activity Details Page)

• Species-related Measures: (TAILS Activity Details Page)

• Scale / Level of Approach: (TAILS Activity)

What Counts in CPA Performance Reporting?
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2013 Performance Reporting:  Conservation Planning Assistance

CPA reports out on 5 measure categories

(Sect. 18 & other stream/shore miles reopened to fish passages)

(Reviewed, Reviewed Early, Derived from 1oA/W T & Agency)

(TA Requests, TA Response, Derived from Event Type & PR )

(Wetland Acres, Shoreline Miles, In-Stream Miles, etc.)

(Large-scale, Program Level, or Standard)

• You may also enter ‘Narratives’ by FY directly in TAILS
• Especially for Large-scale or Program-level efforts
• WO had collected ‘manually’, now done ‘automatically’
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Service Performance Reporting:  How it works

2013 Performance Reporting:  Conservation Planning Assistance

HabITS: Habitat Information Tracking System;  ROAR:  Recovery On-Line Activity Reporting;
TAILS:  Tracking and Integrated Logging System;  TESS: Threatened and Endangered Species System;

Measure
Rule / Logic 

Engine

Measure
Rule / Logic 

Engine

Measure
Rule / Logic 

Engine

ReportsReports
• ESFO Counts
• RO Rollup
• WO Rollup

• ESFO Counts
• RO Rollup
• WO Rollup

Reports
• ESFO Counts
• RO Rollup
• WO Rollup

TESSTESSTESS

ROARROARROAR

PTracPTrac
ReportingReporting

DOIDOI
PTrac

Reporting
DOI

• Data review throughout year
• Access to Rules / Logic
• Data ‘adjustment’ during

reporting window

• Data entry and review throughout year 
• On-line aids to assure complete 

and accurate logging

For example: 14.1.5.1:
Early Non Hydro CPAs
• CPA,
• Reviewed Early,
• Non Hydro Energy,
• Worked on this RY

• Data review during
EOY window only

HabITSHabITSHabITS

TAILSTAILSTAILS

Performance
Tracking 

System

PRS: Performance Reporting System https://ecos.fws.gov/prs
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2013 Performance Reporting:  Conservation Planning Assistance

Service Performance Reporting:  How it works

For example: 14.1.5.1:
Early Non Hydro CPAs
• CPA,
• Reviewed Early, 
• Non Hydro Energy,
• Worked on this RY

Example is from prior RY
IMPORTANT

For Crediting in FY 2013
Metrics referring to dates 
associate w/ Reporting Yr
2013 Reporting Year range

09/01/2012  - 08/31/2013

“Worked on” means
• Start Date in RY,
• Conclusion Date in RY,
• Event Date in RY,
• Staff Hours for FY
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2013 Performance Reporting:  Conservation Planning Assistance

Service Performance Reporting ECOS Integration

For example: 14.1.5.1:
Early Non Hydro CPAs
• CPA,
• Reviewed Early, 
• Non Hydro Energy,
• Worked on this RY

Yep, 
count this one

PRS Report
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34

2013 Performance Reporting:  Conservation Planning Assistance

34

As of May 1, 2009

American Recovery and Reinvestment Act (ARRA) 
(funding source)
Must be logged

Although not in our Operational Plan
and thereby not part of Performance Reporting

It is a critical component to logging
Conservation Planning Assistance Activities
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2013 Performance Reporting:  Conservation Planning Assistance

Bottom Line

• Log what matters to your Office
• Log Nationally Required Fields

Especially:
Action/Work Type,

Lead Agency,
Final Decision Date

and log in “No further Service work performed”
ONLY if you did NO work

• Check the Validation Reports in TAILS
• Review your counts, if desired, in PRS

• Don’t let a ‘count desire’ drive how you log !

Data Quality is EVERYONE’S Responsibility
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TAILS

2013 Performance Reporting

Conservation Planning Assistance
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TAILS

2013 Performance Reporting

Environmental Contaminants
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End-of-Year Performance Measures
2013 Performance Reporting:  Environmental Contaminants

 Devised in 1993 and Requires that Agencies:
• Develop Strategic Plans describing their overall goals/objectives
• Annual Performance Plans w/ quantifiable measures of progress
• Performance Reports describing success in meetings standards 

and measures

 Built from FWS Operational Plan & DOI Strategic Plan
• Includes Government Performance and Results Act (GPRA)
• Program Performance Assessment Rating Tool (PART)
• And more (e.g., American Recovery and Reinvestment Act ?)

 Each Program reports on several metrics
• How Many Activities …
• How Much Acreage …

 Some Measures in Manager’s / Your Performance Plans
 Plans / Performance Reports shared with Congress

• To assist with funding issues / decisions
• To improve performance and efficiencies
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Logging TAILS data for Contaminants 
In TAILS,

TAILS Bundle Code: 21420-2010-B-003
Bundle Title:  Barker Dam
Bundle Description: Reconstruction of hydro dam at Barker Reservoir.

(Section 7 Consultation: 21420-2010-F-0133)

(CPA Activity: 21420-2011-CPA-0007)

(EC Activity: 21420-2011-EC-0065) Events
Activities

TAILS Bundle Code: 21420-2011-B-056
Bundle Title:  Barker Bridge
Bundle Description: Bridge Construction over lower Barker River near Dam

(CPA Activity: 21420-2011-CPA-0782)

(EC Activity: 21420-2011-EC-0216)
Events

Activities

TAILS SuperBundle Code: 21420-2011-SB-001
SuperBundle Title:  Barker Dam and Bridge

you may Log ‘Activities’, add specific details as ‘Events’ , associate
multiple Activities together into ‘Bundles’, put Bundles into‘SuperBundles’

2013 Performance Reporting:  Environmental Contaminants
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What Counts in EC Performance Reporting?

4

Only Activities and some Events Count

TAILS Bundle Code: 21420-2010-B-003
Bundle Title:  Barker Dam
Bundle Description: Reconstruction of hydro dam at Barker Reservoir.

(Section 7 Consultation: 21420-2010-F-0133)

(CPA Activity: 21420-2011-CPA-0007)

(EC Activity: 21420-2011-EC-0065) Events
Activities

TAILS Bundle Code: 21420-2011-B-056
Bundle Title:  Barker Bridge
Bundle Description: Bridge Construction over lower Barker River near Dam

(CPA Activity: 21420-2011-CPA-0782)

(EC Activity: 21420-2011-EC-0216)
Events

Activities

TAILS SuperBundle Code: 21420-2011-SB-001
SuperBundle Title:  Barker Dam and Bridge

• SuperBundles DON’T Count

2013 Performance Reporting:  Environmental Contaminants
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5

Only Activities and some Events Count

TAILS Bundle Code: 21420-2010-B-003
Bundle Title:  Barker Dam
Bundle Description: Reconstruction of hydro dam at Barker Reservoir.

(Section 7 Consultation: 21420-2010-F-0133)

(CPA Activity: 21420-2011-CPA-0007)

(EC Activity: 21420-2011-EC-0065) Events
Activities

TAILS Bundle Code: 21420-2011-B-056
Bundle Title:  Barker Bridge
Bundle Description: Bridge Construction over lower Barker River near Dam

(CPA Activity: 21420-2011-CPA-0782)

(EC Activity: 21420-2011-EC-0216)
Events

Activities

• SuperBundles DON’T Count
• Bundles DON’T Count

2013 Performance Reporting:  Environmental Contaminants
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What Counts in EC Performance Reporting?

6

Only Activities and some Events Count

(Section 7 Consultation: 21420-2010-F-0133)

(CPA Activity: 21420-2011-CPA-0007)

(EC Activity: 21420-2011-EC-0065) Events
Activities

(CPA Activity: 21420-2011-CPA-0782)

(EC Activity: 21420-2011-EC-0216)
Events

Activities

• SuperBundles DON’T Count
• Bundles DON’T Count

2013 Performance Reporting:  Environmental Contaminants
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What Counts in EC Performance Reporting?

7

Only Activities and some Events Count

(Section 7 Consultation: 21420-2010-F-0133)

(CPA Activity: 21420-2011-CPA-0007)

(EC Activity: 21420-2011-EC-0065) Events
Activities

(CPA Activity: 21420-2011-CPA-0782)

(EC Activity: 21420-2011-EC-0216)
Events

Activities

• SuperBundles DON’T Count
• Bundles DON’T Count
• Non Contaminant Activities DON’T Count

2013 Performance Reporting:  Environmental Contaminants
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What Counts in EC Performance Reporting?

8

Only Activities and some Events Count

(EC Activity: 21420-2011-EC-0065) Events

(EC Activity: 21420-2011-EC-0216)
Events

• SuperBundles DON’T Count
• Bundles DON’T Count
• Non Contaminant Activities DON’T Count

2013 Performance Reporting:  Environmental Contaminants
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What Counts in EC Performance Reporting?

9

Only Activities and some Events Count

(EC Activity: 21420-2011-EC-0065) Events

(EC Activity: 21420-2011-EC-0216)
Events

• SuperBundles DON’T Count
• Bundles DON’T Count
• Non Contaminant Activities DON’T Count
• Events DON’T Count (unless ‘Count in PR’     ed and it’s “outbound”)

2013 Performance Reporting:  Environmental Contaminants
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What Counts in EC Performance Reporting?

10

Only Activities and some Events Count

(EC Activity: 21420-2011-EC-0065)

(EC Activity: 21420-2011-EC-0216)

• SuperBundles DON’T Count
• Bundles DON’T Count
• Non Contaminant Activities DON’T Count
• Events DON’T Count (unless ‘Count in PR’     ed and it’s “outbound”)

2013 Performance Reporting:  Environmental Contaminants
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What Counts in EC Performance Reporting?

11

Only Activities and some Events Count

(EC Activity: 21420-2011-EC-0065)

(EC Activity: 21420-2011-EC-0216)

• SuperBundles DON’T Count
• Bundles DON’T Count
• Non Contaminant Activities DON’T Count
• Events DON’T Count (unless ‘Count in PR’     ed and it’s “outbound”)

‘PR unworthy’ Events may be logged
• Are good for Administrative Record
• Are not substantive enough to be ‘PR worthy’

(e.g., clarifying conversations, change meeting date)
• Logger leaves ‘Count as PR’ unchecked

2013 Performance Reporting:  Environmental Contaminants
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What Counts in EC Performance Reporting?

12

Only Activities and some Events Count

(EC Activity: 21420-2011-EC-0065)

(EC Activity: 21420-2011-EC-0216)

• SuperBundles DON’T Count
• Bundles DON’T Count
• Non Contaminant Activities DON’T Count
• Events DON’T Count (unless ‘Count in PR’     ed and it’s “outbound”)
• Habitat-measures DON’T Count (until Activity is Concluded)

• Outbound (response type) Events provide “Action” credits for EC
• Habitat-measures logged via Remediation/Restoration page

(e.g., Riparian Miles, Wetland Acres, Upland Acres, Shoreline Miles)
(logged as Created, Protected, Managed, Enhanced, or Restored)

2013 Performance Reporting:  Environmental Contaminants
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Only Activities and some Events Count

(EC Activity: 21420-2011-EC-0065)

(EC Activity: 21420-2011-EC-0216)

• SuperBundles DON’T Count
• Bundles DON’T Count
• Non Contaminant Activities DON’T Count
• Events DON’T Count (unless ‘Count in PR’     ed and it’s “outbound”)
• Habitat-measures DON’T Count (until Activity is Concluded)

• Outbound (response type) Events provide “Action” credits for EC
• Habitat-measures logged via Remediation/Restoration page 
• Recreation-measures may be logged on the ‘Details’ page of Activities

River Miles, Trail Miles, Shoreline Miles, and Recreational Acres
Must be a NRDA Activity to even see these fields [and be credited])

• Recreation-measures DON’T Count (until Activity is Concluded)

2013 Performance Reporting:  Environmental Contaminants
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Only Activities and some Events Count

(EC Activity: 21420-2011-EC-0065)

(EC Activity: 21420-2011-EC-0216)

• SuperBundles DON’T Count
• Bundles DON’T Count
• Non Contaminant Activities DON’T Count
• Events DON’T Count (unless ‘Count in PR’     ed and it’s “outbound”)
• Habitat-measures DON’T Count (until Activity is Concluded)
• Recreation-measures DON’T Count (until Activity is Concluded)

• Those logged as ‘No Further Service Work Performed’
either “Not necessary/appropriate” or

as “Lack of Service Resources”, DON’T Count

• Those Activities not ‘Worked on’ DON’T Count

2013 Performance Reporting:  Environmental Contaminants
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EC reports out on 5 measure categories

• Habitat-related Measures: (Remediation/Restoration page)

• Action Measures: (Outbound, Performance “worthy” Events)

• Recreation-related Measures: (Activity Details Page)

• NRDA Measures: (Ongoing Activities and Specific Events)

• Amphibian Monitoring Measures: (not TAILS derived)

2013 Performance Reporting:  Environmental Contaminants

(e.g., Number of Upland Acres Enhanced/Restored through NRDA)

(e.g., Number of Contaminant Actions benefiting Migratory Birds)

(e.g., Acres of Recreational Opportunities from NRDA Restorations)

(e.g., Number of NRDA Restoration Plans Completed this FY)

(e.g., Completed Amphibian Monitoring Actions on Refuge lands)
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EC reports out on 5 measure categories

• Habitat-related Measures: (Remediation/Restoration page)

• Action Measures: (Outbound, Performance “worthy” Events)

• Recreation-related Measures: (Activity Details Page)

• NRDA Measures: (Ongoing Activities and Specific Events)

• Amphibian Monitoring Measures: (not TAILS derived)

2013 Performance Reporting:  Environmental Contaminants
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EC reports out on 5 measure categories

• Habitat-related Measures: (Remediation/Restoration page)
Managed / Protected For each Habitat-related Measure category*, with 
Acres / Miles logged under either Managed or Protected column.  

Enhanced / Restored For each Habitat-related Measure category*, with 
Acres / Miles logged under either Created, Enhanced or Restored column.

• Coral Acres
• Deep-water / Near-shore Acres
• In-stream Miles
• Riparian Acres
• Riparian Miles
• Shoreline Miles
• Wetland (Coastal) Acres
• Wetland (Non-Coastal) Acres
• Upland Acres

Habitat-related Measure categories *

Only Acres/Miles with Status of
• Accepted or
• Applied/Completed
may be credited

2013 Performance Reporting:  Environmental Contaminants

• Proposed or 
• Recommended
Don’t Count

And then, only when
Remediation/Restoration Acceptable = Yes

See also next slide

No EOY
Metrics

• Coral Acres
• Deep-water / Near-shore Acres
• In-stream Miles
• Riparian Acres
• Riparian Miles
• Shoreline Miles
• Wetland (Coastal) Acres
• Wetland (Non-Coastal) Acres
• Upland Acres
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Is the EC Activity one of the following?
• Biological / Ecological Technical Advisory Group (BTAG / ETAG) Work, 
• FWS Clean-up,
• NRDAR Activity,
• Pesticide Use Proposal (PUP) / Integrated Pest Management Review, or
• Technical Assistance 

Is the EC Activity one of the following?
• Biological / Ecological Technical Advisory Group (BTAG / ETAG) Work, 
• FWS Clean-up,
• NRDAR Activity,
• Pesticide Use Proposal (PUP) / Integrated Pest Management Review, or
• Technical Assistance 

Yes No

Yes

Is Activity Conclusion Date 
within the reporting period?
Is Activity Conclusion Date 
within the reporting period?

No

Acres/Miles not 
creditable this 

period

Acres/Miles not 
creditable this 

period

Habitat Acres/Miles
can’t be logged

Habitat Acres/Miles
can’t be logged

Acres/Miles may be logged on the 
Remediation/Restoration page,
If logged . . 

Is there a selection for 
*NFSWP?

Is there a selection for 
*NFSWP?

Yes
No

Not 
creditable

Not 
creditable

Is
On/Off Refuge/Hatchery 

Selected (On)?

Is
On/Off Refuge/Hatchery 

Selected (On)? Yes

No

Non-FWS acres/miles 
through NRDA credits
Non-FWS acres/miles 
through NRDA credits

Is it a NRDA
Activity or
Is NRDA-

related “On” ?

Is it a NRDA
Activity or
Is NRDA-

related “On” ?

Is it a NRDA Activity or
Is NRDA-related “On” ?
Is it a NRDA Activity or
Is NRDA-related “On” ?

FWS acres/miles 
through NRDA 

credits

FWS acres/miles 
through NRDA 

credits

Non-FWS and Non NRDA
performance metrics don’t exist

Non-FWS and Non NRDA
performance metrics don’t exist

FWS 
acres/miles 

credits

FWS 
acres/miles 

credits

Yes No

No
Yes

NFSWP = No further Service work performed
• Not appropriate / necessary or
• Lack or Service Resources            (you did no work)

You did workYou did
no work

See also
prior 
slide

2013 Performance Reporting:  Environmental Contaminants

Not on FWS lands

On FWS lands

All Habitat credits:
Credited only if Status is 
• Accepted or
• Applied/Completed &
• Rem/Res Acceptable = Yes

All Habitat credits:
Credited only if Status is 
• Accepted or
• Applied/Completed &
• Rem/Res Acceptable = Yes
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Summary of logged Remediation/Restorations
Sites (portrayed on Details Page)

NOTE:  Values are not subsetted to only “Acceptable/Accepted” acres/miles
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2013 Performance Reporting:  Environmental Contaminants

Example:  Measure 2.3.4: Number of FWS coastal and marine acres 
enhanced/restored through NRDA 
• “FWS” : You must have selected fields to indicate it’s on Refuge/Hatchery,
• “coastal and marine”: Coral, Deep Water/Near-shore and Coastal Wetlands,
• “enhanced/restored”:  Sum of Created, Enhanced and Restored categories,
• “through NRDA”:  You must have claimed NRDA related or a NRDA Activity
• Values on Details page = all values under the Remediation/Restoration logging
• Only those Accepted/Completed Concluded this Fiscal Year will be credited.
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EC reports out on 5 measure categories

• Habitat-related Measures: (Remediation/Restoration page)• Habitat-related Measures: (Remediation/Restoration page)

• Action Measures: (Outbound, Performance “worthy” Events)

• Recreation-related Measures: (Activity Details Page)

• NRDA Measures: (Ongoing Activities and Specific Events)

• Amphibian Monitoring Measures: (not TAILS derived)

• Habitat-related Measures: (Remediation/Restoration page)

• Action Measures: (Outbound, Performance “worthy” Events)

• Recreation-related Measures: (Activity Details Page)

• NRDA Measures: (Ongoing Activities and Specific Events)

• Amphibian Monitoring Measures: (not TAILS derived)

(Managed/Protected, Enhanced/Restored, FWS/Non-FWS Lands)

2013 Performance Reporting:  Environmental Contaminants
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EC reports out on 5 measure categories

• Habitat-related Measures: (Remediation/Restoration page)• Habitat-related Measures: (Remediation/Restoration page)

• Action Measures: (Outbound, Performance “worthy” Events)

• Habitat-related Measures: (Remediation/Restoration page)

• Action Measures: (Outbound, Performance “worthy” Events)
(Managed/Protected, Enhanced/Restored, FWS/Non-FWS Lands)

2013 Performance Reporting:  Environmental Contaminants
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EC reports out on 5 measure categories

• Habitat-related Measures: (Remediation/Restoration page)

• Action Measures: (Outbound, Performance “worthy” Events)

Actions are credited from logged Events based on Event Date
Event Date determines crediting Fiscal Year.  Selections on Details 
page identifies types of credits (e.g, benefiting FWS lands, benefiting 
Marine Mammals, etc).  Multiples are allowed per Activity.

Event must be “Credit worthy”
Count in performance Reporting must be checked.

Event must be “Outbound”
Correspondence Exchange, Correspondence Sent, Site Visit Made, 
Cleanup Certified, Restoration Plan – Final, etc

(Managed/Protected, Enhanced/Restored, FWS/Non-FWS Lands)

2013 Performance Reporting:  Environmental Contaminants

Can’t be logged as "No further Service work performed"

See also
next slide
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Have any “outbound” Events been logged?
These include: Assessment Work Performed, Correspondence Sent, Site Visit Made and many others.
Events that don’t count as “outbound” = Administrative Record Notations, Change of Contaminant 

Activity type, Correspondence Received, E-mail Received, Extension to Due Date 
Authorized/Accepted, Facsimile (FAX) Received, Fast Track Due Date Authorized/Accepted, 

Meeting/Conference Requested, Site Visit Requested, Telephone Call Received, and Other Notations 

Have any “outbound” Events been logged?
These include: Assessment Work Performed, Correspondence Sent, Site Visit Made and many others.
Events that don’t count as “outbound” = Administrative Record Notations, Change of Contaminant 

Activity type, Correspondence Received, E-mail Received, Extension to Due Date 
Authorized/Accepted, Facsimile (FAX) Received, Fast Track Due Date Authorized/Accepted, 

Meeting/Conference Requested, Site Visit Requested, Telephone Call Received, and Other Notations 

Yes No

Yes No

Action not 
creditable this 

period

Action not 
creditable this 

period

Is Activity Conclusion Date 
within reporting period?

Is Activity Conclusion Date 
within reporting period?

Yes
No

Not 
creditable

Not 
creditable

Are there Species or 
Service lands-related

Measure proclamations 
(any Yes selections)?

Are there Species or 
Service lands-related

Measure proclamations 
(any Yes selections)?

No

One Species or Service 
lands-related “Action” 

credit per outbound 
creditable Event with 
Event Date within FY

One Species or Service 
lands-related “Action” 

credit per outbound 
creditable Event with 
Event Date within FY

Yes

NFSWP = No further Service work performed
• Not appropriate / necessary or
• Lack or Service Resources            (you did no work)

You did workYou did
no work See also

prior slide

2013 Performance Reporting:  Environmental Contaminants

Is there a selection for 
*NFSWP?

Is there a selection for 
*NFSWP?

Is Event Date within the 
reporting period?

Is Event Date within the 
reporting period?

Is Count in Performance 
Reporting checked (Yes)?
Is Count in Performance 
Reporting checked (Yes)?

Yes

No No Action creditsNo Action credits

No 
Action 
credits

No 
Action 
credits

Yes

One implied 
“Action” 

credit for each 
Species or 

Service lands-
related 

proclamation

One implied 
“Action” 

credit for each 
Species or 

Service lands-
related 

proclamation

No
Action not 

creditable this 
period

Action not 
creditable this 

period
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EC reports out on 5 measure categories

• Habitat-related Measures: (Remediation/Restoration page)• Habitat-related Measures: (Remediation/Restoration page)

• Action Measures: (Outbound, Performance “worthy” Events)
(Managed/Protected, Enhanced/Restored, FWS/Non-FWS Lands)

2013 Performance Reporting:  Environmental Contaminants

From Species and Service-Lands
Related Measures section of Details page

Tribal benefit action credits determined by:
• Lead Agency is a Tribe, or
• Technical Assistance Type is Tribal (if a TA)
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• Habitat-related Measures: (Remediation/Restoration page)

• Action Measures: (Outbound, Performance “worthy” Events)

• Recreation-related Measures: (Activity Details Page)

• NRDA Measures: (Ongoing Activities and Specific Events)

• Amphibian Monitoring Measures: (not TAILS derived)

EC reports out on 5 measure categories

(Benefiting FWS lands, T&E species, etc. from Event Type & PR )

(Managed/Protected, Enhanced/Restored, FWS/Non-FWS Lands)

2013 Performance Reporting:  Environmental Contaminants
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• Habitat-related Measures: (Remediation/Restoration page)

• Action Measures: (Outbound, Performance “worthy” Events)

• Recreation-related Measures: (Activity Details Page)

• NRDA Measures: (Ongoing Activities and Specific Events)

• Amphibian Monitoring Measures: (not TAILS derived)

EC reports out on 5 measure categories

• Habitat-related Measures: (Remediation/Restoration page)

• Action Measures: (Outbound, Performance “worthy” Events)

• Recreation-related Measures: (Activity Details Page)

• NRDA Measures: (Ongoing Activities and Specific Events)

• Amphibian Monitoring Measures: (not TAILS derived)

(Benefiting FWS lands, T&E species, etc. from Event Type & PR )

(Managed/Protected, Enhanced/Restored, FWS/Non-FWS Lands)

2013 Performance Reporting:  Environmental Contaminants
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EC reports out on 5 measure categories

• Habitat-related Measures: (Remediation/Restoration page)

• Action Measures: (Outbound, Performance “worthy” Events)

• Recreation-related Measures: (Activity Details Page)
(Benefiting FWS lands, T&E species, etc. from Event Type & PR )

(Managed/Protected, Enhanced/Restored, FWS/Non-FWS Lands)

2013 Performance Reporting:  Environmental Contaminants

Available only when Activity Type is “NRDAR Activity” (Details page)
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Is the EC Activity a 
NRDA Activity?

Is the EC Activity a 
NRDA Activity?

Yes

No

Yes

Is Activity Conclusion Date 
within the reporting period?
Is Activity Conclusion Date 
within the reporting period?

No

Recreational 
Opportunity 

Acres/Miles not 
creditable this 

period

Recreational 
Opportunity 

Acres/Miles not 
creditable this 

period

Recreational Opportunity Acres/Miles
can’t be logged

Recreational Opportunity Acres/Miles
can’t be logged

Recreational  Opportunity Acres/Miles 
may be logged on the Details page,
If logged . . 

Is there a selection for 
*NFSWP?

Is there a selection for 
*NFSWP?

Yes

No

Not 
creditable

Not 
creditable

Is
On/Off Refuge/Hatchery 

Selected (On)
or

Refuge/Hatchery selected?

Is
On/Off Refuge/Hatchery 

Selected (On)
or

Refuge/Hatchery selected?
Yes

No

Non-FWS recreational opportunity
acres/miles through NRDA credits
Non-FWS recreational opportunity
acres/miles through NRDA credits

NFSWP = No further Service work performed
• Not appropriate / necessary or
• Lack or Service Resources            (you did no work)

You did work

You did
no work

2013 Performance Reporting:  Environmental Contaminants

Not on FWS lands

On FWS lands
Not 

creditable
Not 

creditable
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EC reports out on 5 measure categories

• Habitat-related Measures: (Remediation/Restoration page)

• Action Measures: (Outbound, Performance “worthy” Events)

• Recreation-related Measures: (Activity Details Page)

• NRDA Measures: (Ongoing Activities and Specific Events)

• Amphibian Monitoring Measures: (not TAILS derived)

(Managed/Protected, Enhanced/Restored, FWS/Non-FWS Lands)

(Benefiting FWS lands, T&E species, etc. from Event Type & PR )

2013 Performance Reporting:  Environmental Contaminants

(For NRDAR Activities only, Recreational River Miles, etc.)
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EC reports out on 5 measure categories

• Habitat-related Measures: (Remediation/Restoration page)

• Action Measures: (Outbound, Performance “worthy” Events)

• Recreation-related Measures: (Activity Details Page)

• NRDA Measures: (Ongoing Activities and Specific Events)

• Amphibian Monitoring Measures: (not TAILS derived)

(Managed/Protected, Enhanced/Restored, FWS/Non-FWS Lands)

(Benefiting FWS lands, T&E species, etc. from Event Type & PR )

(For NRDAR Activities only, Recreational River Miles, etc.)

2013 Performance Reporting:  Environmental Contaminants
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EC reports out on 5 measure categories

• Habitat-related Measures: (Remediation/Restoration page)

• Action Measures: (Outbound, Performance “worthy” Events)

• Recreation-related Measures: (Activity Details Page)

• NRDA Measures: (Ongoing Activities and Specific Events)

(Managed/Protected, Enhanced/Restored, FWS/Non-FWS Lands)

(Benefiting FWS lands, T&E species, etc. from Event Type & PR )

(For NRDAR Activities only, Recreational River Miles, etc.)

2013 Performance Reporting:  Environmental Contaminants

Annual measures of 
• NRDAR Restorations in Progress,*
• Case Settlements Completed,
• Restoration Plans Final,
• Restoration Projects Completed,
• Sites / Cases with all Restoration Actions Completed.

Event Date determines
Fiscal Year of crediting

NRDAR Activities without
an Activity Conclusion Date
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Is the EC Activity a 
NRDA Activity?

Is the EC Activity a 
NRDA Activity?

Yes

No

Yes

Is Activity Conclusion Date 
within the reporting period?
Is Activity Conclusion Date 
within the reporting period?

No

A “NRDAR in Progress” 
credit is given

A “NRDAR in Progress” 
credit is given

NRDA-specific metrics can’t be logged 
nor credited

NRDA-specific metrics can’t be logged 
nor credited

NRDA-specific information/Events may be logged 
If logged . . 

Were any NRDA 
Events logged?

Were any NRDA 
Events logged?

No
Yes

Not 
creditable
for these 
NRDA-
specific 
metrics

Not 
creditable
for these 
NRDA-
specific 
metrics

Is Count in Performance 
Reporting checked (Yes)?
Is Count in Performance 
Reporting checked (Yes)? Yes

Yes

Settlement Completed creditSettlement Completed credit

2013 Performance Reporting:  Environmental Contaminants

Not creditable in this 
reporting period

Not creditable in this 
reporting period

Is Event Date in 
reporting period?
Is Event Date in 

reporting period?

No

Restoration Plan Completed creditRestoration Plan Completed credit

Restoration Project Completed creditRestoration Project Completed credit

All Restoration Actions Completed creditAll Restoration Actions Completed credit

With corresponding logged Event
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EC reports out on 5 measure categories

• Habitat-related Measures: (Remediation/Restoration page)

• Action Measures: (Outbound, Performance “worthy” Events)

• Recreation-related Measures: (Activity Details Page)

• NRDA Measures: (Ongoing Activities and Specific Events)

(Managed/Protected, Enhanced/Restored, FWS/Non-FWS Lands)

(Benefiting FWS lands, T&E species, etc. from Event Type & PR )

(For NRDAR Activities only, Recreational River Miles, etc.)

2013 Performance Reporting:  Environmental Contaminants

• Habitat-related Measures: (Remediation/Restoration page)

• Action Measures: (Outbound, Performance “worthy” Events)

• Recreation-related Measures: (Activity Details Page)

• NRDA Measures: (Ongoing Activities and Specific Events)

• Amphibian Monitoring Measures: (not TAILS derived)
(For NRDAR Activities only, Specific NRDA Event Types)
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What Counts in EC Performance Reporting?

51

EC reports out on 5 measure categories

• Habitat-related Measures: (Remediation/Restoration page)

• Action Measures: (Outbound, Performance “worthy” Events)

• Recreation-related Measures: (Activity Details Page)

• NRDA Measures: (Ongoing Activities and Specific Events)

• Amphibian Monitoring Measures: (not TAILS derived)

(Managed/Protected, Enhanced/Restored, FWS/Non-FWS Lands)

(Benefiting FWS lands, T&E species, etc. from Event Type & PR )

(For NRDAR Activities only, Recreational River Miles, etc.)

2013 Performance Reporting:  Environmental Contaminants

(For NRDAR Activities only, Specific NRDA Event Types)

(Refuges based measures, TAILS will NOT be used to derive)
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Service Performance Reporting:  How it works

HabITS: Habitat Information Tracking System;  ROAR:  Recovery On-Line Activity Reporting;
TAILS:  Tracking and Integrated Logging System;  TESS: Threatened and Endangered Species System;

Measure
Rule / Logic 

Engine

Measure
Rule / Logic 

Engine

Measure
Rule / Logic 

Engine

ReportsReports
• ESFO Counts
• RO Rollup
• WO Rollup

• ESFO Counts
• RO Rollup
• WO Rollup

Reports
• ESFO Counts
• RO Rollup
• WO Rollup

TESSTESSTESS

ROARROARROAR
PTracPTrac

ReportingReporting
DOIDOI

PTrac

Reporting
DOI

• Data review throughout year
• Access to Rules / Logic

• Data entry and review throughout year 
• On-line aids to assure complete 

and accurate logging

For example: 2.2.2:
FWS Upland Acres Enhanced/Restored NRDA
• TAILS Contaminant Activity
• Created, Enhanced, or Restored,
• Upland Acres, On FWS lands
• NRDAR Activity or NRDA related
• Completed This Fiscal Year

• Data review during
EOY window only

HabITSHabITSHabITS

TAILSTAILSTAILS

Performance
Tracking 

System

PRS: Performance Reporting System https://ecos.fws.gov/prs

2013 Performance Reporting:  Environmental Contaminants
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Service Performance Reporting:  How it works

For example: 2.2.2:
FWS Upland Acres 
Enhanced/Restored NRDA

• Contaminant Activity,
• Created, Enhanced, or 
Restored
• Upland Acres,
• NRDAR Activity or 
NRDA related
• Completed This Fiscal 
Year

2013 Performance Reporting:  Environmental Contaminants



Not shown on this page (also not shown on this page “FWS lands”

*
123.45 acres will count 

in measure 2.2.2
from this Activity/Site

this Fiscal Year
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Service Performance Reporting ECOS Integration
For example: 2.2.2:
FWS Upland Acres Enhanced/Restored 
NRDA

• TAILS Contaminants Activity,
• Created, Enhanced, or Restored
• Upland Acres, On FWS lands
• NRDAR Activity or NRDA related
• Completed This Fiscal Year

Yep, 
count this one

PRS Report

2013 Performance Reporting:  Environmental Contaminants



Mark Jacobsen (505) 248-6662

Jason Duke (931) 525-4986 28

TAILS
Phase 6

T
A
I
L
S

racking

ntegrated

ogging

ystem

nd

Bottom Line

Log what matters to your Office
Log Nationally Required Fields

Log Remediation/Restoration work
Log Credit-worthy Events (at least)

Make Species and Service-Lands Selections

Check the Validation Reports in TAILS
Review your counts, if desired, in PRS

Don’t let a ‘count desire’ drive how you log !

Data Quality is EVERYONE’S Responsibility

2013 Performance Reporting:  Environmental Contaminants
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TAILS

2013 Performance Reporting

Environmental Contaminants



Shepherdstown, WV                                             TAILS: Advanced Tracking & Integrated Logging System 
2013                                                                                                  National Conservation Training Center 
 

 

 
Mapping TAILS Data 
 
 
 
 
Session Objectives:  At the conclusion of this session, you will be able to: 
 
 

 
 Understand how to access the TAILS Mapper 

 
 Be able to export your report result to the TAILS Mapper 

 
 Successfully navigate within and use features of the 

TAILS Mapper 
 

 Be able to export your report results to Google Earth 
 

 Successfully navigate through and use features of Google 
Earth 

 
 Know how to use Google Earth to create a GIS (.kml) file 

and upload it to a TAILS Activity 
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Using
the ECOS Mapper

as an extension to TAILS 

(and especially to define or 
edit a point location)
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Using the TAILS Mapper to define/edit a point location

A little background
 Since Day 1, in TAILS you could define location:

– Via a discrete point location, or
– Via a GIS file (which you uploaded to TAILS)

 Format of discrete point location may be:
– Latitude/Longitude (Decimal Degrees),
– Latitude/Longitude (Degrees, Minutes, Seconds), or
– Universal Transverse Mercator (UTM) Coordinates

 SuperUser defines 1 of the above as office default
– Made available during initial logging of Core Info pg
– But all three are always presented on Location page

 Mapper now allows you to define via map click
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Using the TAILS Mapper to define/edit a point location

Logging a new Activity

Complete the 
“Core 

Information” 
page and 

click 
“Create”
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Using the TAILS Mapper to define/edit a point location

Activity is created and Code defined
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Using the TAILS Mapper to define/edit a point location

Navigate to and edit Location Page

Either enter
the data directly:
Lat/Long (DD)

Lat/Long (DMS)
UTM Coordinates

or

Use the Mapper



TAILS
Phase 6

T
A
I
L
S

racking

ntegrated

ogging

ystem

nd

6

Using the TAILS Mapper to define/edit a point location

Mapper launched w/ Office Jurisdiction

Your office’s jurisdiction outline
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Using the TAILS Mapper to define/edit a point location

Using the “Zoom In” Tool

Mapper launched w/ Office Jurisdiction
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Using the TAILS Mapper to define/edit a point location

Zooming in to area of interest
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Using the TAILS Mapper to define/edit a point location

Other Map Controls

Zoom Out Tool

Pan Tool

Zoom to Full Extent Tool

Zoom to
Prior Map

Tool Zoom to
Next Map

Tool

Zoom 
Scroll 
Bar
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Using the TAILS Mapper to define/edit a point location

Showing and Activating Map Layers
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Using the TAILS Mapper to define/edit a point location

Turning on a Map Layer

Layer Transparency Control
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Using the TAILS Mapper to define/edit a point location

Hiding Layer Elements
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Using the TAILS Mapper to define/edit a point location

Other Layer Controls

Layer Order Controls

Access Layer MetaData

Download Layer Shapefile (GIS File)



TAILS
Phase 6

T
A
I
L
S

racking

ntegrated

ogging

ystem

nd

14

Using the TAILS Mapper to define/edit a point location

Showing Base Layers
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Using the TAILS Mapper to define/edit a point location

Changing Base Layer
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Using the TAILS Mapper to define/edit a point location

Changing Base Layer
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Using the TAILS Mapper to define/edit a point location

Defining a Layer for Identify Tool

Relocate Map Tool Window
(click, hold, move, unclick)

Minimize Window Button

Close Window Button

Base Layers Scroll Bar
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Using the TAILS Mapper to define/edit a point location

Identifying a Layer Feature

• Review Summary Information
• Access the TAILS record itself
• Access Species Profiles
•Access Uploaded Documents
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Using the TAILS Mapper to define/edit a point location

Accessing Draw Mode
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Using the TAILS Mapper to define/edit a point location

Defining location by drawing on Mapper
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Using the TAILS Mapper to define/edit a point location

Defining location by drawing on Mapper



TAILS
Phase 6

T
A
I
L
S

racking

ntegrated

ogging

ystem

nd

22

Using the TAILS Mapper to define/edit a point location

Refining the location; Zooming in
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Using the TAILS Mapper to define/edit a point location

Refining the location; Repositioning
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Using the TAILS Mapper to define/edit a point location

Refining the location; Repositioning
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Using the TAILS Mapper to define/edit a point location

Saving the Location Information

• Click the Save Button on the Editor
• Location saved as Decimal Degrees
• Converted to original format as needed
• Confirmation that data was Saved
• Returns you to TAILS Activity
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Using the TAILS Mapper to define/edit a point location

Location Saved; Returned to Activity

Location saved

Will be saved in original 
format (DD, DMS, UTM)

Other Location fields 
completed or updated 
automatically (via behind-
the-scenes GIS intersect)
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Using the TAILS Mapper to define/edit a point location

Summary
• Create an Activity to begin
• Navigate to Edit: Location
• Click link to use Mapper to enter coordinates for point location
• Zoom in, Zoom out, Pan
• Zoom to Prior Map, Next Map, Map Extent
• Add or Hide Layers
• Show or Hide Map Layer Elements
• Reorder Layers
• Adjust Layer Transparency
• Change Base Map
• Scroll through Layers
• Minimize, Close and Reposition Tool Windows
• Identify information from other TAILS points as desired
• Toggle between Activity Pages, uploaded docs, etc and Mapper
• Draw, Move and Save new point location, get new intersects
• Access Layer MetaData
• Download Layer Shapefile (GIS file)
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Using the TAILS Mapper to define/edit a point location

Coming Soon
• Portraying Compensatory Mitigation sites (CPA) on Mapper

• Portraying Remediation/Restoration sites (EC) on Mapper

• Portraying uploaded GIS files (for any Module) on Mapper

• Use the Mapper to Enter/Edit Compensatory Mitigation Points (CPA)

• Use the Mapper to Enter/Edit Remediation/Restoration Points (EC)

• Define location (via Mapper or otherwise) with multiple points / Activity

• Define location (via Mapper or otherwise) with a linear feature

• Define location (Mapper or otherwise) with a polygonal feature

• Define location w/ multi-poly or multi-liner features (via Map/otherwise)
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Using
the ECOS Mapper

as an extension to TAILS 

(and especially to define or 
edit a point location)
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Using
Google Earth

as
a TAILS extension
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Using Google Earth as a TAILS extension

Mapping in TAILS - Comparisons
TAILS Mapper allows you to map your point data

– Internet based, FWS developed (ECOS)

– Multi-layers with some tools

Google Earth allows you to map your  point data

– Internet based, private 

– Multi-layers with some tools

Cannot compare
to ArcMap

Each is
very different
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Using Google Earth as a TAILS extension

Choosing the data to Map

– Select from the wide array of Reports

– You need not include attributes

– Run the report, scroll to the bottom, choose an option:

Mapper

Google Earth

TAILS Mapper or Google Earth
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Using Google Earth as a TAILS extension

Google Earth:
Geo-Browser/Virtual Globe

⁻ Stand alone interface

⁻ Owned/distributed by Google

⁻ Versions (Free, Plus, Pro, ES)

⁻ Allowable by USFWS - Solicitor General: 

“The majority of DOI’s uses are internal, in order to assist the employ
in their research tasks.  This is permissible under the “free” license. “

Uses‘KML’ & ‘KMZ’ files to portray data

– KML = Keyhole Markup Language

– KMZ is, essentially a zip/compressed version of KML
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Using Google Earth as a TAILS extension

Google Earth:
Google Earth (Free version)

– Displays satellite imagery

– Varying resolutions and sources

• 15 meter baseline resolution 

• 1 meter or less in and around most urban areas

• Dates of imagery vary, currently most ~ 2007 (free version)
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Using Google Earth as a TAILS extension

Google Earth:
Google Earth (Free version)

– Allows overlay of data from KML/KMZ files

• Can’t directly import other GIS files

– shapefiles / geodatabases / GPS data / CSV files

• Shapefiles may be converted to KML files (demo)

– Allows you to draw points, lines, polygons, take 
measurements, review historic images, get “street-
level” views, record “flyover” videos and more.
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Run a TAILS Report (e.g., Activities by FY)

Export - Download to KML

 If the result is small – it will open immediately
– Allow the KML to auto-open

 If the result is large – KML is e-mailed to you
– Access email and click on link provided (it will auto-open)

Review the mapped result in Google Earth

Using Google Earth as a TAILS extension

Download to KML
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Using Google Earth Extension
Using Google Earth as a TAILS extension

Google Earth Street-level View

Use Google Earth to:
 Determine / Confirm coordinates
 To aid in site visit scoping
 To review historic imagery

 View spatial relationships
 Get directions
 Record a ‘video review’ of site
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Using Google Earth as a TAILS extension

Shape Files to KML
Conversion Methods

– ArcMap/Toolbox (demo)

– Xtools Pro

– GPS Garmin

– Others

Each is a bit different & gives differing results

Try them all to see what you get / like



TAILS
Phase 5

T
A
I
L
S

racking

ntegrated

ogging

ystem

nd

Using Google Earth as a TAILS extension

Shapefile to KML (in ArcMap)
Review in ArcMap, check symbology
Toolbox

– Navigate to Conversion Tools: Layer to KML
• Double-click ‘Layer to KML’
• Select the symbolized ‘layer’
• Define the output file (KML)
• Define the Scale (try 1000)
• Click ‘OK’

Double Click
KML

 .KML
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Using Google Earth as a TAILS extension

Demo of Google Earth
Direction of view

Pan location

Zoom in/Out Bar

‘Fly to’ field

Places (includes layers you add)

Layers

Main Window
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Using
Google Earth

as
a TAILS extension
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Using Microsoft Excel as a extension to TAILS 
 
 
 
 
Session Objectives:  At the conclusion of this session, you will be able to: 
 
 

 
 Understand your TAILS report content 

 
 How to use Microsoft Excel to enhance the use and 

understanding of your TAILS data 
 

 Generate a Pivot Table and Pivot Chart from a TAILS 
report data 

 
 Create Slicers within a Pivot Table  

 
 Use Conditional Formatting to enhance Excel data 

 
 Understand the use of the Filtering tool within Excel 
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Using
Microsoft Excel

as
a TAILS extension

Pivot Tables & Pivot Charts  
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TAILS Reports:  Getting your data out
TAILS has a large set of Reports, including;

– Office Reports, Ad-Hoc Reports, Geographic Reports, etc
Query these focused reports and review result,
Reports provide query result summary / export.

Office Reports
Ad-Hoc Reports

Setting a Query Definition
Reviewing Report Result

Summary & Exports

Excel as an
Export Option

Using Excel as a TAILS extension: Pivot Tables/Charts
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Trends of Utah CPAs with ‘Power’ Action/Work TypesAll Utah Conservation Planning Assistance Activities

TAILS Reports:  Getting your data out
Excel is seen as an extension to TAILS

– No need to recreate Excel’s capabilities in TAILS
– Hierarchical Sorting, Filtering, Pivot Tables/Charts

Using Excel as a TAILS extension: Pivot Tables/Charts

Raw data export from TAILS Storytelling Data/Charts
Turn this In to this

Here’s how.
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FY3FY1 FY2

Primary Action / Work Type A

Primary Action / Work Type B

Primary Action / Work Type C

Primary Action / Work Type D

Primary Action / Work Type E

# # #

# # #

# # #

# # #

# # #

Pivot Table Example 
Let’s look at Utah’s ‘Power’ CPAs over time

– A number of reports could get us the raw data
– Let’s get a count of ‘Power’ Activities per year
– We’ll use Pivot Tables/Charts to tell the story

Using Excel as a TAILS extension: Pivot Tables/Charts

All Utah Conservation Planning Assistance Activities

Raw data export from TAILS # = The number of CPA Activities in this Primary 
Action/Work Type & in this Fiscal Year with ‘power’
in the Primary Action/Work Type Description.

Only Primary A/W T w/ ‘power’

Trends of Utah CPAs with ‘Power’ Action/Work Types

Storytelling Data/Charts
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Selecting the data to ‘pivot’
Select the entire dataset with Control + ‘A’ or 

Using Excel as a TAILS extension: Pivot Tables/Charts

Click here.

Data table
will

‘highlight’
in

light blue.
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Build a Pivot Table
From the ‘Insert’ tab, select ‘Pivot Table’.

Using Excel as a TAILS extension: Pivot Tables/Charts

Select
the ‘Insert’

tab.

Select to
insert a

‘Pivot Table’
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Build a Pivot Table
Accept the defaults and click ‘OK’.

Using Excel as a TAILS extension: Pivot Tables/Charts

Accept
default.

Put into
a new

worksheet.

Click OK.
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Build a Pivot Table
Understanding the ‘Pivot Table Wizard’.

Using Excel as a TAILS extension: Pivot Tables/Charts

Pivot Table Field List

Pivot Table Filter Area

Pivot Table Columns Area

Pivot Table Row Area

Pivot Table Values Area

Pivot Table Worksheet Area

Pivot Table Wizard
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Build a Pivot Table
Place a field (Primary Action/Work Type) in Row Labels.

Using Excel as a TAILS extension: Pivot Tables/Charts

9

Single click
on

Field Name
in

Field List

Hold
Mouse
button

down and 
drag to

Row Area

Place a field (Primary Action/Work Type) in Row Labels.

Release
Mouse
Button
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Build a Pivot Table
Place a field (Fiscal Year) in Column Labels.

Using Excel as a TAILS extension: Pivot Tables/Charts

10

Single click
on

Field Name
in

Field List

Hold
Mouse
button

down and 
drag to

Columns
Area

Release
Mouse
Button

Place a field (Fiscal Year) in Column Labels.
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Build a Pivot Table
Place a field (Activity_Code) in Values Area.

Using Excel as a TAILS extension: Pivot Tables/Charts

11

Single click
on

Field Name
in

Field List

Hold
Mouse
button

down and 
drag to
Values
Area

Release
Mouse
Button

Place a field (Activity_Code) in Values Area.
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Build a Pivot Table
Filter the Content: Select only desired columns

Using Excel as a TAILS extension: Pivot Tables/Charts

12

Activate
‘Column
Labels’
Picklist

Uncheck
‘blank’

Every
Activity
has FY
so there

will be no
‘blanks’

Click
‘OK’



TAILS
Phase 5

T
A
I
L
S

racking

ntegrated

ogging

ystem

nd

Build a Pivot Table
Filter the Content: Select only desired rows.

Using Excel as a TAILS extension: Pivot Tables/Charts

13

Activate
‘Row

Labels’
Picklist

Select
‘Label
Filters’

Click
‘OK’

Let’s get
only those

with ‘Power’

Select
‘Contains’

Type
‘Power’
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Pivot Table is complete
Number of ‘power’ CPAs per FY

Using Excel as a TAILS extension: Pivot Tables/Charts

Presented in this way – you, your staff 
or your manager may better be able to:
• Visualize patterns
• See relationships
• Portray ratios

and more.What data is 
associated with these 

values?

Double-click a value 
in a Pivot Table to see 
the original data that 
made up that count

Data may also be easily portrayed as:
• Percent of Row,
• Percent of Column
• Percent Difference
• Count, Sum, Max. Min and Std Dev
and more.



TAILS
Phase 5

T
A
I
L
S

racking

ntegrated

ogging

ystem

nd

15

Pivot Table is complete
Number of ‘power’ CPAs per FY

Using Excel as a TAILS extension: Pivot Tables/Charts

Other than Utah’s Power CPAs slowing,
there is not much of a ‘story’ here.
Do you need to tell a story?
Try making a pivot table to help.
or
Otherwise use Pivot Tables to make your
data more presentable or more useful.

 Determine the data you need to tell your story, or
 Otherwise better understand and portray the information,
 Run a TAILS Report that will provide that needed data,
 Export that report result to Excel, and
 Make a Pivot Table

This was only an introduction to Pivot Table Reports

Your turn.

Make a
Pivot Table
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Build a Pivot Chart from a Pivot Table
Let’s make a bar chart from our Pivot Table

Using Excel as a TAILS extension: Pivot Tables/Charts

1616

Assure
’Insert’ tab

is active

Select
the area to
chart with

Click, Drag,
Release

Select ‘100%

Stacked
Column
in 3D’

Select
‘Column’

from Charts 
sectionSelecting this chart type allows us to see

the relative amount that each Fiscal Year (column)
contributed to each Action/Work Type (row) total.
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Pivot Chart is complete
Focused results to address issue or tell story.

Using Excel as a TAILS extension: Pivot Tables/Charts

1717

Fiscal Year
(columns)

Legend

Filter access
for 

continuous
reselection

Filtered
Action/Work

Types
(rows)
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Pivot Tables / Chart are dynamic
Pivot Tables have dynamic connections to data

Using Excel as a TAILS extension: Pivot Tables/Charts

1818

So you can
reselect
and see
instant
results

Further
filter

Fiscal Year

Also: you
may edit

the raw data
and the

Pivot Table
and Chart
will update
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Pivot Tables / Chart are dynamic
Pivot Tables are dynamic connections to data.

Using Excel as a TAILS extension: Pivot Tables/Charts

1919

Your turn

Make a
Pivot Chart

From your
Pivot Table
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How to use Pivot Tables / Pivot Charts
Try this one to show the ‘Top 10’ A/W Types

Using Excel as a TAILS extension: Pivot Tables/Charts

Clear all the
filters by
setting

Columns
and Rows to
‘Select All’

Select
Value Filters

Select
‘Top 10’

Select
Row Labels

picklist



TAILS
Phase 5

T
A
I
L
S

racking

ntegrated

ogging

ystem

nd

21

How to use Pivot Tables / Pivot Charts
Try this one to show the ‘Top 10’ A/W Types

Using Excel as a TAILS extension: Pivot Tables/Charts

Accept
‘Top 10’

Click
‘OK’
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How to use Pivot Tables / Pivot Charts
Try this one to show the ‘Top 10’ A/W Types

Using Excel as a TAILS extension: Pivot Tables/Charts
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How to use Pivot Tables / Pivot Charts
Try this one to show the ‘Top 10’ A/W Types

Using Excel as a TAILS extension: Pivot Tables/Charts

Here is a
donut chart

of these
Top 10Inner ring = 2006

Outer ring = 2009 Pivot Tables
and

Pivot Charts
can be very

powerful
and

somewhat
tricky.

Use them
with any

Excel data
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Using
Microsoft Excel

as
a TAILS extension

Pivot Tables & Pivot Charts  
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Electronic Records Management 
 
 
 
 
Session Objectives:  At the conclusion of this session, you will be able to: 
 
 

 
 Use and understand the TAILS Administrative Record 

Report 
 

 Convert documents to Adobe Acrobat (.pdf) format 

 Define and explain the purpose of Bates stamping 

 Bates stamp an administrative record 

 Effectively manage electronic documents in TAILS 

 Describe the benefits of using the ECOS Digital 
Document Library 
 

 Use scanning to create electronic documents 

 Understand your options for file-naming conventions and 
storage 
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Electronic Records 
Management

in TAILS
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Managing Electronic Records in TAILS allows you to:
 Find documents with ease
 Have easy access to documents uploaded to TAILS
 Create reports that show all the documents that you 

have queried
 Download documents from ECOS server or local 

servers
 Create Hyperlinked Indexes that are easy to use by 

your customers
 Allows for electronic storage of CDs on site

Electronic Records Management in TAILS

Benefits
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Work with your IT Department to decide
where to store electronic records

• make a partitioned drive on a dedicated server
• or make a folder on a shared drive/server

Electronic Records Management in TAILS

Storing Electronic Records
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By Folder
By File Name
By identifiable numbers

• Date
• TAILS assigned numbers
• Paper file numbers
• By Year

Electronic Records Management in TAILS

Decide Naming Conventions
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Electronic Records Management in TAILS

Decide Naming Conventions
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 Documents can be uploaded to TAILS and 
become part of the EDDL

 Always accessible
 All documents conveniently located with 

Activity Record
 PDFs will be text searchable (coming soon)
 Available to the Administrative Record 

Report

Electronic Records Management in TAILS

ECOS Digital Document Library
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 Aids in assembling an admin record
 Gathers all electronic docs associated with Activity or Event
 Can serve as hyperlinked index file
 Coming soon:  All associated uploaded docs can be zip-and-

shipped as a group

Electronic Records Management in TAILS

Administrative Record Report
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 It doesn’t matter what software you are 
using to scan in documents just so the 
end result is a PDF file

National Archives and Records 
Administration (NARA) will accept 
electronic files in PDF format

Assembling Electronic Administrative Records

Scanning
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 It is very important to get your naming scheme down for electronic 
documents. Here are some samples:
– Literature Cited example: Holecheketal1998.pdf or 

ScholtenBunting2001.pdf
– In litt example: BLM2000inlitt.pdf or Debolt1998inlitt.pdf
– Pers comm. example: QuinneyWeavers1998pc.pdf or 

Cooke2002pc.pdf
– E-mail example (and this is real important because of the 

volume of e-mails) email_96_1015_154p_Rey.pdf (Because 
of the way that a computer alphabetizes its files it is important 
to identify it as an email then put the year and then the date, 
then the time of the e-mail and then the name of the sender.) 

– Fax example: Fax_96_0117_NTaylor.pdf
– Memo example: Memo_96_513_USFWS.pdf
– Letter example: Letter_96_607_Ruesink.pdf

Assembling Electronic Administrative Records

Naming Scheme



TAILS
Phase 5

T
A
I
L
S

racking

ntegrated

ogging

ystem

nd

10

 Complete an Index for the Administrative Record.
- This must be done before you organize electronic files BUT 

does not have to be done before scanning is done.
 Convert your index to PDF
 After the Index is completed and there are no more changes then 

you must organize your electronic records.
– Number your Index (Select All…Format….Bullets and 

Numbering….Select numbering)
– You will need to go to your electronic folder and number 

documents by order of the Index.  Example:  
0001_FRvol55no35_22190.pdf, 
0002_letter_91_0128_DHoyem.pdf, 
0003_letter_91_219_DQuinney.pdf 
0004_letter_91_1220_DQuinney.pdf

– Remember the computer is going to put it in order of the first 
character and then the second and so on.  If  you know it is 
going to be a big document start with 000 or 0000

Assembling Electronic Administrative Records

Index Creation
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After electronic documents are 
organized according to the index now 
you can do one of two things:
– Hyperlink PDF files to the index:  Use 

Acrobat 5.0 or higher. 
– Or Bates Stamp 

• Required for Court hearings

Assembling Electronic Administrative Records

Hyperlink or Bates Stamp
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Open your PDF index using Acrobat Professional

Assembling Electronic Administrative Records

Hyperlinking
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Find the linking tool on toolbar (two chains that link together)
Select the text that you want to hyperlink

Assembling Electronic Administrative Records

Hyperlinking
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A dialog box will pop-up.
Select the Appearance properties.
Under Action - Select Open File:

Assembling Electronic Administrative Records

Hyperlinking
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Browse to the file that you want to hyperlink and select it. 
You will now see the file that is linked.

Assembling Electronic Administrative Records

Hyperlinking
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 Burn CD
Make sure that everything is in the same folder 

 Check that all links are there
– It is always nice to have some one else check 

your work before sending it. (QA/QC)
– Always make directions for using the CD
SAMPLE: 
(You must have Adobe Acrobat Reader to read this CD
Place CD in drive…open folder
Click on 00_Index
Hover over the entry that you would like to view and click. Click on back arrow to get 

back to the index.)

 Package it all up and send to your Customer

Assembling Electronic Administrative Records

After Hyperlinking
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Bates Stamping:
http://www.afabonline.com/

Scanners:
www.canon.com
http://www.usa.canon.com/opd/controller?act=OPDC

ategoryIndexAct&fcategoryid=2204

Adobe Acrobat Professional:
http://www.adobe.com/products/acrobat/

Scansoft Paperport 9 (11)
http://www.nuance.com/products/

Electronic Records Management in TAILS

Resources
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TAILS Final Project 

 
FROM THE TRAINING SERVER (https://ecos-training.fws.gov) 

 Log a new Activity (Section 7) 

 Define a new Bundle while you're logging it 

 Complete all the Nationally Required Fields and save/create this Activity 

 Go to the reference page and “add another” electronic document for this Activity 

(and select the option to “keep local”) 

 Add a new Event to this Section 7 

 Use the magic button to create a CPA from it 

 Make edits as desired/directed and save/create this CPA Activity 

 Add an Event to this Activity 

 Upload a Document (to the Digital Doc Library) for this Event 

 Launch Google Earth 

 Enter (fly to) your home address 

 Get the Latitude/Longitude Coordinates (as decimal degrees) 

 Add this information to your Location page of one of these Activities 

 Print the Missing Required Info page for the CPA Activity (as a pdf) 

 Go to Activity Summary and print this page (as a pdf) 

 Note the Bundle Code and access the Bundles tab (at the top) 

 Search for the new Bundle you just created and access the Activity Report and 

print it (as a pdf) 

 Go to the Electronic Documents Report and print this page (as a pdf) 

 Run a Species Report for 2013 (being sure to “include GIS links”) and Export it to 

pdf and print the first 2 pages 

 Export this same species report to Excel (Save / Name it) 

 Open the exported file with Excel and create a Pivot Table and Chart and then 

print the chart (as a pdf) 

 Export your species report to Google Earth 

 Zoom in, Use Identify and Print your map (as a pdf) 
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Introduction to ArcGIS 10 
 
 
 
 
Session Objectives:  At the conclusion of this session, you will be able to: 
 
 

 
 Open and define a map document 

 Set up toolbars 

 Add, reorder and remove GIS layers 

 Turn layers on and off 

 Change symbology for a layer 

 Zoom in/out on selected locations 

 Manipulate, Select, and Sort records in an attribute table 
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SECTION 1 - Opening a Map Document (.mxd) 
 

1. Start ArcMap by clicking the icon on your desktop.   
 
 
 
 
 

 
2. Go to up to the Main Menu select File>Open 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
 
 
 
 

3. Navigate to the X:\TAILS folder. Select the TAILS map document 
(TAILS.mxd) and click Open.   

 
 
 
 

TIP: If accessing a geodatabase, going to File> Map Document Properties 
and then setting the default will allow the user to go directly to the selected 
goedatabase when adding data or using the ArcCatalog Window. 
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SECTION 2 - The ArcMap Interface & Viewing Layers  
 
The ArcMap 10 interface is composed of 3 major components; The Table of Contents, 
Data View and Tool bars – depending upon which ones are activated or displayed.   
The window on the left side is the Table of Contents which holds individual data layers 
contained within a Data Frame (Tennessee-TAILS).  These layers are displayed or 
drawn in the Data View (right window) according to their sequence in the table of 
contents, going from the bottom to the top. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
Note, the Tennessee-TAILS data frame title appears as bold text. This indicates it is 
the active data frame. 
 

1.      Check (draw) and un-check the Major Roads layer within the Table of 
Contents .  

 
2.      Next, toggle between TNCongressional and TNPhysiographic data layers.  

 
3.      Click on the small plus box to the left of the TNPhysiographic layer.  What 

happens?   
 

4.      Toggle between the Oil/Gas wells, TAILS and Cell towers. 
 
 When finished, leave the Counties and Major Cites displayed (checked).   

Table of 
 Contents 

Main Menu  

Data Frame  

Data View 

Tools  
Toolbar 

Standard Toolbar 
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SECTION 3 - Toolbars and Customization 
 
The ArcMap interface can easily be customized by displaying or hiding various tool 
bars.  The toolbars can also float on the desktop or be docked or displayed as a tab.  
ArcMap retains the location and visibility of the toolbars (your personal settings) in a 
file called the normal template (normal.mxt).  As a result, each time you start an 
ArcMap session, the toolbar environment appears in the same state as your 
previous session.    

 
1. From the Customize>Toolbars and uncheck the Standard toolbar.   This 

toggles the tool bar off.  Toggle the standard toolbar on and off.  Take note of 
the toolbar location.  After determining where this toolbar resides, ensure the 
Standard toolbar is visible. 

 
 
 
 
 

 
2. Repeat the procedures in step 1 for the Tools toolbar. 

 
 
 
 
 

3. Repeat the procedures in step 1 for the Draw toolbar. 
 
 
 
 
 
 

4. Repeat the procedures in step 1 for the Layout toolbar. 
 
 
 
 
 

5. Click and hold the left edge (4 vertical dots) of the Standard toolbar. Drag the 
bar to the left side of the interface.   The toolbar will snap into place (become 
docked) along the left edge  
 
TIP:  Grab the 4 vertical dots (usually on the left edge or on top of the toolbar) 
to move toolbars that are docked.  A floating toolbar can be moved by clicking 
anywhere on the title bar. 

 



Shepherdstown, WV                                             TAILS: Advanced Tracking & Integrated Logging System 
2013                                                                                                  National Conservation Training Center 
 

 4

6. Reposition the Tools, Draw & Layout  toolbars.  
 
7. Reposition the Layout toolbar so that it floats above the map display. 
 

TIP:  You can float the table of contents on your desktop as well.  Give it a try! 
 

8. Now that you are comfortable moving and docking toolbars, let’s set up the 
interface we are going to use throughout the course.  First, dock the Layout 
toolbar along the left side of the interface.   Move all other toolbars back to 
their original locations.   Your interface should now look similar to the example 
below. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

9. Close out the Table of Contents  
 
10. Click on the Table of Contents 

window button located on Standard 
Tool bar.     

 
11. Click on the Auto Hide pin on the Title 

bar. What happens? 
 

12. Click on the Table of Contents tab to 
pop-out the window/display. 



Shepherdstown, WV                                             TAILS: Advanced Tracking & Integrated Logging System 
2013                                                                                                  National Conservation Training Center 
 

 5

 
13. Click on the Auto Hide pin again to keep the window on the interface.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
14. From the View menu, uncheck the Status Bar.  Take note of its location (at 

the bottom left and right of the ArcMap interface). Ensure the status bar is 
visible. 

 
The status bar is useful for obtaining helpful descriptions about the function of 
specific buttons.   

 
15. Move your mouse pointer over any icon located on the Tools toolbar.  

 
The name of that icon will be displayed in a callout.  Additionally, a brief 
description of the function will be displayed in the status bar. Determine the 
name and function for each icon/button within the Tools tool bar.   

 
16. Repeat this procedure for icons on the Standard, Draw & Layout tool bars.  
 
17. For more details on using ArcMap’s many features, click Help on the Main 

Menu.  Select ArcGIS Desktop Help.  (A shortcut to help is pressing F1).   
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SECTION 4 - Navigating the Data View                                                     
                      

1. Activate the Zoom Tool and draw a box around Nashville, TN or any major city 
within the State with the left mouse key. 

 
 
 
 
 
2. Right click on the Counties>Zoom to Layer. What happens?  

 
 

3. Click on the Full Extent button. What happens? 
 

 
4. Experiment/Explore with the other navigation options located on the Tools tool 

bar.   
 

 
TIP:  For more details on the function of an icon, click the What’s This? 
button located on the Standard toolbar.  Then try clicking on some icons you 
wish to get more details from.  

 
Quiz: Describe the effects of the following actions: 

 
 Zoom to Full Extent      
 
 Fixed Zoom In/Out     
 

Go Back to Previous Extent      
 

 Zoom In Tool      
 

Zoom Out Tool      
 
Pan Tool      
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SECTION 5 - Data Frames Properties  
 
Data Frames have a specific set of properties that define how data layers are displayed 
in the Data View. 
 

1. Right click on the Counties >Zoom to Layer 
 

Notice the scale information on the standard tool bar and the coordinate 
information on the status bar in your Tennessee-TAILS data frame (as circled 
below).  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. To work with the properties of the Data View, select Data Frame Properties 

from the View pull-down menu at the top of the screen.  
 
(An alternate way to access the Data Frame Properties is by double-clicking on 
the data frame or by right-clicking on the data frame and selecting Properties.)  

 
3. Click on the General tab. 
 

Notice that the map units are set to feet. This indicates this data frame has     
been assigned a coordinate system. 

 
4. Click on the Coordinate System tab.   

What is the current coordinate system of this data frame?  
 
______________________________________________  
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5. Go back to the General tab and change the display units to “decimal degrees.”  
 

 
 
6. Change “Tennessee-TAILS” in the “Name:” field to “Tennessee”. 
 
7.  Close the Data Frame Properties window by clicking OK. 
 
8. What’s different?  _________________________________________  

 
Where can you see the effects of these changes?  _________________  
 
 

 
 
 
 
 
 
 
 



Shepherdstown, WV                                             TAILS: Advanced Tracking & Integrated Logging System 
2013                                                                                                  National Conservation Training Center 
 

 9

SECTION 6 - Inserting New Data Frames & Changing Projections  
 
Inserting Data Frames 
 

1. Click on Insert>Data Frame.   
 

At the bottom of the Table of Contents, you 
should have a new data frame appear. 

 
2. Right click on New Data Frame> Properties. 
 
3. Click on the General tab. Change the Name 

from “New Data Frame” to “United States”.  
 

4. Click OK.   
 
5. Click on the Add Data button.  

 
 

 
 

 
6. Navigate to the USA located under the TAILS folder and select the states.shp 

file. 
 

7. Right click on the United States data frame>Properties.  
 

8.  Click on the Coordinate System tab.  
 
Notice the current coordinate system is 
GCS_North_American_1983.  Let’s change 
that. 

 
9. Click  Predefined > Projected Coordinate 

Systems> Continental> North America> 
USA_ Contiguous_ Albers_ Equal Area_ 
Conic.  

 
10. Once your screen matches the one on the 

right, click OK.  
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11. Right click on the States> Properties.  This opens the Layer Properties dialog.   
 

12. Click on the General tab.  Change the Layer name from “states” to “United 
States”.  Once you have done this, click OK. 

 
 

How and what has the shape of the lower 48 changed by changing the 
coordinate system? 
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SECTION 7- Moving Layers  
 
Moving Layers – The location of layers in the Table of Contents (TOC) dictates the 
sequence in which the layers will be drawn.  Layers on the bottom are drawn first.   
 

1. Let’s go back to the Tennessee Data Frame. 
Right click the Tennessee Data frame> 
Activate. 

 
2. Make sure Counties, TAILS, Major Cities and 

the Roads layers are displayed (checked).  
 

3. Right click on the Counties>Zoom to Layer  
 

4. Click on and drag the Counties layer to the top 
of the table of contents.  
 
What happens to the roads, Major cities and TAILS points? 

 
5. Move the TAILS point layer to a position above the Counties layer.  What 

happens to the TAILS points now? How about the roads?  
 
Does the sequence/order of the layers within the Table of Contents make a 
difference?  
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Section 8 - Identify Tool  
 
 Information associated with each layer can be viewed using the Identify tool. 
 

1. In the Tennessee data frame, ensure the Counties and Major Cities layers are 
checked.  

 
2. Select the Identify tool. 

 
 
 
   

3. Position the Identify tool over any feature (polygon) in the data view and single 
click the left mouse button.  An Identify Results window will appear.  

 
4. Select Counties from the Identify from pull down menu.  Note, <Top-most 

layer> is the default setting.  
 
 
 
 
 
 
 
 
 
 
 
 
 

5. View the attributes for the polygon(s) in the Identify window.  
 
6. Click on a different county polygon and view the results.  
 
7. Change the identify from  pull down from Counties to Major Cities – click on 

a variety of cities (purple) throughout the State. 
 
8. Close the Identify Results window. 
 

TIP:  Multiple features can be accumulated in the Identify window.  Using the 
Identify tool click on one feature then hold down the shift key and select other 
features.  You can click on each feature in the window to view its associated 
attributes.  To remove features from the window, right-click and select “Remove 
from Tree.”   
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Section 9 - Viewing & Selecting Records  
 
The attribute information or database associated with any layer can be viewed in a 
tabular format.   
 

1. Select/highlight the Counties layer in the TOC.   
 
2. Right mouse click> Open Attribute Table. 

 
 

 
 

3. Use the arrow buttons or slider bars to scroll both horizontally and vertically 
through the table to view all the records for the County layer. 

 
4. Double click on the Table title bar and then the Auto Hide pin.  

 
 

5. Activate the Select Features tool.  
 
 
 
 

 
6. Move the cursor over any county polygon and click on the polygon.  The selected 

polygon will now be highlighted with a blue outline. Hold down the shift key and 
select multiple counties.  
 

7. Click on the Table tab. 
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8. At the bottom of the Counties table window, click the Show selected records. 
The polygons you selected in the data view now appears in a separate table. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

9. Click on the Clear Selection button located at the top of the table. The selected 
polygon features on the map and corresponding selected records in the table are 
now cleared. 

 
10. Ensure the Select Feature tool is still selected.  With the left mouse key, draw a 

box around several counties within the State - release the mouse button.  All 
counties within or touching the box are now selected. 

 
11.  View the table by clicking the table tab. 

 
12.  Click the Show selected records button.  

 
13. Use the bottom scroll bar to move across the table to 

the right until you see the COUNTY field.  Right mouse 
click on the field header. 

 
 

14. From the dropdown menu, select Sort Descending. 
Notice that all records are now sorted in descending 
order by County name. 
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15. From the Selection menu, choose Clear Selected Features.  The selected 
feature(s) on the map and corresponding selected record(s) in the table are now 
cleared. 
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SECTION 10 - Changing Symbology/ Fill Color   
 
The layer attributes and their display characteristics (e.g., the color, line width, font size) 
can be changed using the Symbol Selector and the Layers Properties.   
 

1. Open the TAILS map document and activate the Tennessee_TAILS data 
frame if it is not already active. 

 
2. Right click on Counties>Zoom to Layer.  

 
3. Double-click on the Counties layer in the TOC to open the Layer Properties 

window. Click on the Symbology tab.  
 

Notice in the left window under Show, the data Category is being displayed as 
Single Symbol.   

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

4. Click on Categories>Unique Values. 
 

5. Under Value Field, click the dropdown arrow.  This lists all of the data fields 
(from the attribute table) for the Counties layer. Change this to COUNTY using 
the drop down arrow. 
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6. Click on Add All Values button. Note all the county names in TN populate the 
Symbol/Value/Label and Count Windows 

 
7. Under Color Ramp, click the drop down arrow.  Scroll down and observe all of 

the color schemes you can use to display the polygon data for Counties. Also 
notice the Symbols and Labels values correspond to what is shown in the table 
of contents.  

 
8. Select a color scheme (your choice) from the color ramp and the click on OK.  

 
What happened to all the counties in TN?  
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Section 11 - Using the Symbol Selector  
 

1. Double click Counties. Repeat steps 4-6 in as outlined above in Section 10 
 

Once again, we see a 
listing of the Symbol, 
Value, Label, and Count 
of all of the different 
County names within the 
State of Tennessee.  
 

2. Scroll down the list of 
counties names (values) 
and locate Putnam.  

 
3. Double-click on the 

symbol/legend box next 
(left) to Putnam.   
 
This opens the Symbol Selector window.  The Symbol Selector window allows 
you to manipulate a polygon feature’s fill color, outline width, and outline color.  
Notice in the upper right hand corner you see a preview of the changes that you 
are about to make.   

 
4. Change the color of Putnam by clicking on the Yellow (Sun) solid fill symbol. 
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5. Click OK, to save and close the Symbol Selector window.   

 
6. Click OK again to exit out of the Layer Properties window.  Note the change to 

Putnam County in the data view.   
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Section 12 - Changing Symbology through the Legend (TOC) 
 

1. Expand the legend by clicking on the small box just to the right of the County 
layer 

 
2. Scroll down the legend and locate Putnam. 

 
3. Click the box next to Putnam. 

 
4. This takes you back into the Symbol Selector window, where you can make any 

color changes as necessary to the counties layer. 
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 SECTION 13- Changing  Symbols 
 

By default ArcMap loads only a handful of symbol sets for you to use.  The current set 
of symbols may not suit your specific needs.  For example, you may want an outline of 
a tower or some other graphic to represent your cell towers.  Follow these steps to 
load a new symbol set: 

 
1. Double-click on Cell Tower symbol to open the Symbol Selector.   

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
2. Scroll down through the list of symbols to 

see what is currently available.   
 

3. Click on the Style References button.  
 

4. Scroll down, check Utilities>OK 
 

5. Notice the addition of utility-based symbols 
to the Symbol Selector.  
 
Scroll down the window to see the additional 
symbols.  
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ArcMap has an extensive selection of map symbols - ranging from Business to 
Real Estate to Hazmat and everything else in between.  
 

6. Click on the View Options button, select Group by Style and then Group by 
Category to see the differences.  

 
7. Select a Utility symbol or any symbol of your choice. Click OK to view your 

change in the data view.  
 

 
TIP:  The default marker can easily be changed in appearance as a quick 
solution.  Click on the Properties button in the Symbol Selector to change the 
style, color, and size.   
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Queries and Spatial Analysis 
 
 
 
 
Session Objectives:  At the conclusion of this session, you will be able to: 
 
 

 
 Perform an Attribute query 
 
 Perform a Definition query  
 
 Export  a query as a shape file  

 
 Conduct advanced spatial analysis 
 
 Select by location (Theme on Theme Queries) 

 
 Perform a Spatial Join  
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SECTION 1- Basic Queries (Selecting by Attributes) 
 
We are going to select features within a layer that meet a set of 
criteria we define.  These selected features can then be used for 
later analyses such as summaries. 
 

1. Ensure that only TAILS and Counties data layers are 
drawn. 

 
2.  On the Main Menu click Selection>Attributes.  

 
The Select by Attributes window appears.  Notice you 
have two drop down menus at the top dealing with 
Layers and Methods.  Underneath these, you have 
Fields in the middle, Operators to the left and Unique Values on the right. 

 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
3. Click on the drop down arrow beside Layer and select the TAILS layer.  

 
Notice after you did this there were changes in the types and number of fields 
listed. The Method you want is to Create a new selection, so there is no need 
to change this. 
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4. In the Fields area, double-click on the Work_Type field.  The word 
“WORK_TYPE” will appear in the window below as the first building block of your 
query expression. 

 
5. Single-click on the equals sign.  It will be added to the query expression being 

built in the window below. 
 

6. Click on Get Unique Values. 
 

7. Double-click on the value Contaminant Incident in the Values box.  Make sure 
it is added to the query expression in the window below.  The entire constructed 
query should match the one shown below: 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

8. Click the Apply button and then Close.   
 

What happened in your Data View?  Notice that all of the Contaminant Incidents 
have the boundaries highlighted.  

 
9. Choose Select by Attributes again from the Selection menu. 

 
10. Press the Clear button at the bottom left to clear out the bottom window where 

the query expression appears so you can build your next query from scratch. 
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11. Again, choose TAILS as the layer you want to query, but this time choose  Add 
to current selection for the Method. 

 
 

12.  Complete the fields to match the window shown below: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
13.    Click Apply, then click Close.  
 

Notice that the Section 7 Consultations are added now to the selection of 
Contaminant Incidents. 

 
14.   Right click on TAILS layer, choose Selection, and select Clear Selected   

Features.  What happens? 
 

Both Contaminant Incident and Section 7 Consultation could have been 
selected simultaneously by building a compound query expression (OR) rather 
than by doing two separate queries as we did above.  Adding a second field 
value using a compound expression requires repeating the whole expression 
as shown below: 
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15. Close the Select By Attributes dialog box. 
 

16. From the Selection menu, choose Clear Selected Features. The TAILS layer is 
now back in its original form. 
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SECTION 2 - Layer Definition Queries 
 
Now we are going to define features within a theme that we want to include in our 
view, excluding the features we do not want.  This is done through the Layer 
Properties window.   
 
1. Check the Cell Towers layer in the TOC and un-check the TAILS point layer. 
 
2. Right-click on the Cell Towers >Properties.   

 
 

3. Click on the Definition Query tab and click on the Query Builder button.   
 

 
Notice it looks similar to the Select by Attributes window except for a view 
differences in some of the buttons at the bottom. Queries are constructed in the 
same way as before.  

 
4. Change  the fields to match the window  shown  below:  

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. Click OK to close the Query Builder.   
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Notice that the new query appears in Query Builder dialogue box as shown 
below: 
 
 
 
 
 
 
 
 
 
 
 
 

6. Click OK to close out of the Layer Properties window and submit your query. 
 

Only cell towers from Bellsouth Mobility appear in the Data View window and 
observe nothing is highlighted in cyan. 

 
7. Right-click on the Cell Tower layer and select Open Attribute Table.  What is 

now missing from the table?  Close the attribute table and return to the Data 
View. 

 
8. Double-click on the Cell Tower layer and go back to the Definition Query tab.   

 
9. Press the Delete key.  Click OK in the Layer Properties window and notice the all 

the cell towers are displayed again in the data view.  
 
 

Discussion – What’s the difference between (1) building your query using the 
Select by Attributes method and (2) building your query using the Layer 
Properties>Definition Query method?  How are the results different?   

  
 
 
 
 
 
 
 
 
 
 
 
 



Shepherdstown, WV                                             TAILS: Advanced Tracking & Integrated Logging System 
2013                                                                                                  National Conservation Training Center 
 

 8

SECTION 3 - Saving Queries as Shapefiles 
 
Shapefiles can be generated from the result of an attribute or definition query. The 
selected features will be saved as an entirely new data set and saved onto your hard 
drive.  
 

1.  Go to Selection> Clear Selected Features.   If this function is disabled or 
grayed out, no features are currently selected. 

 
2. Choose Select by Attributes from the Selection menu.   

 
3. Using the TAILS data layer, build a query that will select two separate 

Work_Types.   
 
Hint: You can either add to the current selection or build a compound expression.  
 

4. Right-click on the TAILS>Data>Export.   
 

5. Make sure that you have Selected features chosen to export.  
 
You want to use the same Coordinate system as the layer’s source data.   

 
 

 
 

6. In the Output shapefile or feature class, navigate to the directory/folder you 
want and save the shapefile.  

 
7.  Click OK when satisfied. ArcMap will ask you… 
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8. Click Yes. 
 

The shapefile will appear at the top of the TOC in the Tennessee Data Frame.  
 
9. Check the new shapefile data layer to display it in the data view.  
 

You may want to turn off TAILS data layer.  Note, it contains only the 
Work_Types that were selected through the Select by Attributes query. 

 
10. Open the attribute table to verify the export was successful. 
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SECTION 4 - Select by Location  
 
Finding Point features that are completely within Polygon features 
 
Select by location allows the user to find features that are completely within polygon 
features. In this exercise, lets locate all of the TAILS points that are completely within 
the city limits of Nashville, TN.  

 
1. Use the Select by Attributes query to select the 

boundaries of Nashville from the Major Cities Layer.  
Do you remember how to do this? 

 
2. Check the TAILS data layer to display the points 

 
3. Right click on Major Cities>Selection>Zoom to selected  

 
4. Go to Selection>Select By Location.  

 
5. Change all the fields to match the window shown below: 

 
 
 
 
 
 
 
 
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. Click Apply, and then click Close. 
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All of the TAILS locations in Nashville are now selected and highlighted in blue.   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
7. Right mouse click on the TAILS>Open Attribute Table.   
 
8.  Click on Show all of the records button.  

 
9. Click on the Options button and select Clear Selection.   

 
10. Close the Attributes of the TAILS table. 
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Finding point features that are within a specified distance of specific line feature 
 
Let’s find all TAILS points that are within 4 miles of Interstate 40 in Tennessee.  
 

1. Turn off all of the layers except for TAILS, County Boundaries, and Major 
Roads layers. 

 
2. Perform a Definition Query to select and display only Interstate 40 from the 

Major Roads layer.   
 
Note: Use the ‘I40’ value in the RTE_NME field to select Interstate 40. 

 
3. Go up to the Selection>Select By Location. You want to select features from 

the TAILS layer that are within 4 miles the Major Roads layer.  Change all the 
fields to match the window shown below: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.   Click Apply, and then click Close.  
 

All of the TAILS points within 4 miles of I-40 are now highlighted in cyan. 
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Select features within a specified distance from another feature 
 
Find all of the ARAPs (Aquatic Resource Alteration Permits) from the TAILS layer that 
are within 10 miles of Interstate I-24.  
 

1. Clear all of your selected features AND definition queries used in the previous 
exercise.   

 
2. Perform a Definition Query isolating Interstate I-24 (RTE_NME = I24) from the 

Major Roads layer. 
 

3. Using the Definition Query again, query all the ARAP’s from the TAILS layer.  
 
Hint: You need to create a wildcard query on the Title field of the TAILS layer 
with LIKE ‘%ARAP%’ to pick up all ARAP projects.  

 
4. Go up to the Selection>Select By Location.  Select features from TAILS layer 

that are within a distance of 10 miles from the features of the MAJOR ROADS 
layer.  Your screen should match the example below.  Click Apply, and then click 
Close.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

All of the ARAPs that are within 10 miles of an Interstate I-24 are now highlighted.   
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SECTION 5 - Spatial Joins  
 
Joining points to polygons based on location 
 
Join the TAILS points to the Tennessee Congressional House Districts to determine the 
House member who has the most TAILS points of activities reviewed by the Cookeville 
ES Office in their district. 
 

1. Clear all of your selected features from the layers used for the previous 
exercises. 

 
2. Right-click on the TNCongressional layer in the TOC and select Joins and 

Relates>Join. 
 
Note that this is the same Join window that is used for tabular joins.  The main 
difference is that in the ‘What do you want to join to this layer?’ box that you 
need to select ‘Join data from another layer based on spatial location’ instead of 
a join based on attributes 
 

3. Your screen should match the window below: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

. 
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Spatial joins can be run in two different manners.  In this example, we are going 
to produce a polygon join that contains the Congressional district polygons and 
sums the number of TAILS points in each district and adds a field with the name 
of ‘Count’ that contains the sum of points in that polygon.  
The other type of spatial join would occur if one right-clicked on the TAILS layer 
and spatially joined it to the Congressional layer.  This would result in a layer 
that contained all TAILS points and added the attributes of the Congressional 
district to each point of the district that it falls within.  
 
This process would take longer since one would have to open that attribute table 
and right-click on the name of the Congressional district and run a Summarize 
operation to obtain the count value. 

 
4. Run this spatial join by clicking OK. Your new spatial join layer will now be added 

to the table of contents.   
 
5.  Right click on the new layer and open the attribute table.  

 
6.  Right click on the Count field and select Sort Descending.  Congressman Van 

Hileary should have the most TAILS points in his district with a total of 148. 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

Now that you understand how to perform a spatial join, perform a new spatial join 
between the TAILS Points and TNPhysiographic to determine which 
physiographic province in Tennessee contains the most TAILS points and write 
the name of that physiographic province (ECO_NAME field) on the line below. 
 
________________________________ 
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Using Arc Map as a TAILS extension 
 
 
Session Objectives:  At the conclusion of this session, you will be able to: 
 
 

 
 Associate (and upload) a shapefile to a TAILS Activity 

 Export your office shapefile from TAILS 

 Export GIS-ready attributes from TAILS to ArcMap 

 Add TAILS data to ArcMap 

 Use a Spatial Attribute Join to portray TAILS data 
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Using ArcMap as a TAILS extension

A little background
♦ ArcMap is the main component of ESRI’s 

ArcGIS suite of geospatial processing programs.

♦ Used primarily to view, explore, edit, create and 
analyze geospatial data.

♦ Allows the user to explore datasets, symbolize 
features, create maps and has many extensions 
itself.

♦ It is the Service/DOI standard GIS (Geographic 
Information System) software.

♦ TAILS data is easily used within ArcMap.
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Using ArcMap as a TAILS extension

How it’s done
♦ Actions needed to use TAILS data in ArcMap

1. Download your base shapefile from TAILS
2. Download your desired data from TAILS
3. Join your data to your shapefile in ArcGIS
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♦ Actions needed to use TAILS data in ArcMap
1. Download your base shapefile from TAILS
2. Download your desired data from TAILS
3. Join your data to your shapefile in ArcGIS
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Using ArcMap as a TAILS extension

How it’s done
♦ Actions needed to use TAILS data in ArcMap

1. Download your base shapefile from TAILS
2. Download your desired data from TAILS
3. Join your data to your shapefile in ArcGIS

To download, go to Reports: 
Geographic Reports: 
Shapefile of office and regional activities:

Download your office shapefile
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Using ArcMap as a TAILS extension

How it’s done
♦ Actions needed to use TAILS data in ArcMap

1. Download your base shapefile from TAILS
2. Download your desired data from TAILS
3. Join your data to your shapefile in ArcGIS

When prompted, Save the zipped file
Zipped files are compressed
Contain all the parts (files) of the shapefile

Locate where you want it
Name it (default is org code)
Click the Save button
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Using ArcMap as a TAILS extension

How it’s done
♦ Actions needed to use TAILS data in ArcMap

1. Download your base shapefile from TAILS
2. Download your desired data from TAILS
3. Join your data to your shapefile in ArcGIS

As file downloads, uncheck this box
Wait for download to complete
Click the Open button

Click “Use Evaluation Version”
Your interface may look different
Built in to newer Windows OS
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Using ArcMap as a TAILS extension

How it’s done
♦ Actions needed to use TAILS data in ArcMap

1. Download your base shapefile from TAILS
2. Download your desired data from TAILS
3. Join your data to your shapefile in ArcGIS

Peek into .zip file contents
Shapefiles are really multiple files
Same file name, different extensions

Select them all
Or select none (same as all)
Click the “Extract” button
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Using ArcMap as a TAILS extension

How it’s done
♦ Actions needed to use TAILS data in ArcMap

1. Download your base shapefile from TAILS
2. Download your desired data from TAILS
3. Join your data to your shapefile in ArcGIS

Note file extensions
Once extracted, .shp.xml will change
Becomes simply .xml

Extracted, looks something like this
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Using ArcMap as a TAILS extension

How it’s done
♦ Actions needed to use TAILS data in ArcMap

1. Download your base shapefile from TAILS
2. Download your desired data from TAILS
3. Join your data to your shapefile in ArcGIS

Delete the .zip file (if desired) Rename shapefile (if desired)
If so, must rename each file the same
Keeping file extensions unaltered
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Using ArcMap as a TAILS extension

How it’s done
♦ Actions needed to use TAILS data in ArcMap

1. Download your base shapefile from TAILS
2. Download your desired data from TAILS
3. Join your data to your shapefile in ArcGIS

Open ArcMap
Click on Add Data
Navigate to and Select

your shapefile

Select layer in TOC
Right-click on layer name
Select Zoom to Layer (if desired)

TAILS points in ArcMap
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Using ArcMap as a TAILS extension

How it’s done
♦ Actions needed to use TAILS data in ArcMap

1. Download your base shapefile from TAILS
2. Download your desired data from TAILS
3. Join your data to your shapefile in ArcGIS

ACTIV_TITL LEAD_OFFIC ACTIV_CODE ACTIV_TYPE FISCAL_YR

ETTP Ponds EE/CA 42430 42430-2010-EC-0001 Environmental Contaminant Activity 2010

QORE  Proposed Lowe's Store 42430 42430-2010-TA-0001 Section 7 Consultation 2010
. . . . . . . . . . . . . . .
Memphis Cement Company 42430 42430-2010-CPA-0481 Conservation Planning Assistance Activity 2010

Select layer in TOC
Right-click on layer
Select  “Open Attribute Table”

Note shapefile attribute table has
Minimal attributes
10 character header limit
ACTIV_CODE (Activity Code)
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Using ArcMap as a TAILS extension

How it’s done
♦ Actions needed to use TAILS data in ArcMap

1. Download your base shapefile from TAILS
2. Download your desired data from TAILS
3. Join your data to your shapefile in ArcGIS

Symbolizing TAILS points based on attributes (very few in base shapefile)
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Using ArcMap as a TAILS extension

How it’s done
♦ Actions needed to use TAILS data in ArcMap

1. Download your base shapefile from TAILS
2. Download your desired data from TAILS
3. Join your data to your shapefile in ArcGIS

♦ Actions needed to use TAILS data in ArcMap
1. Download your base shapefile from TAILS
2. Download your desired data from TAILS
3. Join your data to your shapefile in ArcGIS

Run any TAILS Office or Ad-Hoc Report
Review the Report results in TAILS
Export using the “ArcMap” option

Note that all of these reports have a column with data for Activity Code
Activity Codes are used as the unique identifiers for Activities
They are the basis for performing the data attribute Join in ArcMap
Activity Code will be the Primary Key (linking data) for the Join
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Using ArcMap as a TAILS extension

How it’s done
♦ Actions needed to use TAILS data in ArcMap

1. Download your base shapefile from TAILS
2. Download your desired data from TAILS
3. Join your data to your shapefile in ArcGIS

♦ Actions needed to use TAILS data in ArcMap
1. Download your base shapefile from TAILS
2. Download your desired data from TAILS
3. Join your data to your shapefile in ArcGIS

When prompted, select Save
Name and Locate the file as desired

Uncheck here, while downloading
When prompted, select Open
If you missed the chance to uncheck

Locate and Open file
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Using ArcMap as a TAILS extension

Special Notes and Tricks
♦ Actions needed to use TAILS data in ArcMap

1. Download your base shapefile from TAILS
2. Download your desired data from TAILS
3. Join your data to your shapefile in ArcGIS

♦ Actions needed to use TAILS data in ArcMap
1. Download your base shapefile from TAILS
2. Download your desired data from TAILS
3. Join your data to your shapefile in ArcGIS

Note that no matter what you named it
It’s still “TAILS_ArcMap_Report”
in this dialog box.

Don’t worry – it was saved as named.

Note that it says it’s MS Excel (.xls)
It’s actually a text file (tricked ya)
But, we’ll fix that next.

Good news!  Once you set this to unchecked, it will stay that way.
When unchecked, you can just click Open when download is complete.
Your chance to uncheck it can come and go fast,
so download a large file if only to get this unchecked.
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Using ArcMap as a TAILS extension

How it’s done
♦ Actions needed to use TAILS data in ArcMap

1. Download your base shapefile from TAILS
2. Download your desired data from TAILS
3. Join your data to your shapefile in ArcGIS

♦ Actions needed to use TAILS data in ArcMap
1. Download your base shapefile from TAILS
2. Download your desired data from TAILS
3. Join your data to your shapefile in ArcGIS

When you first open this ArcMap file in MS Excel, you’ll get this warning.
Excel has recognized that it’s a text file disguised as an Excel file.
Click “Yes” to verify that the file is not corrupt (tricky yes, corrupt no).
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Using ArcMap as a TAILS extension

How it’s done
♦ Actions needed to use TAILS data in ArcMap

1. Download your base shapefile from TAILS
2. Download your desired data from TAILS
3. Join your data to your shapefile in ArcGIS

♦ Actions needed to use TAILS data in ArcMap
1. Download your base shapefile from TAILS
2. Download your desired data from TAILS
3. Join your data to your shapefile in ArcGIS

Note that Headers use underscores (not spaces) – required in ArcMap.
Note that our Primary Key (Activity_Code) is included as a column.
We have all manner of other data we can Join to the shapefile.
Once in ArcMap, we can use / symbolize these data.
Now, save as a true MS Excel file via “Save as”.
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Using ArcMap as a TAILS extension

How it’s done
♦ Actions needed to use TAILS data in ArcMap

1. Download your base shapefile from TAILS
2. Download your desired data from TAILS
3. Join your data to your shapefile in ArcGIS

♦ Actions needed to use TAILS data in ArcMap
1. Download your base shapefile from TAILS
2. Download your desired data from TAILS
3. Join your data to your shapefile in ArcGIS

Save as MS Excel 97-2003
Filename.xls

Save as MS Excel (2007)
Filename.xlsx

or

Now it’s truly Excel



TAILS
Phase 6

T
A
I
L
S

racking

ntegrated

ogging

ystem

nd

19

Using ArcMap as a TAILS extension

How it’s done
♦ Actions needed to use TAILS data in ArcMap

1. Download your base shapefile from TAILS
2. Download your desired data from TAILS
3. Join your data to your shapefile in ArcGIS

♦ Actions needed to use TAILS data in ArcMap
1. Download your base shapefile from TAILS
2. Download your desired data from TAILS
3. Join your data to your shapefile in ArcGIS

♦ Actions needed to use TAILS data in ArcMap
1. Download your base shapefile from TAILS
2. Download your desired data from TAILS
3. Join your data to your shapefile in ArcGIS

In ArcMap, Select Add Data
Double-click MS Excel file or
Select file and click “Add”

Now select the Excel worksheet
Double-click worksheet name or
Select worksheet and click “Add”
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Using ArcMap as a TAILS extension

How it’s done
♦ Actions needed to use TAILS data in ArcMap

1. Download your base shapefile from TAILS
2. Download your desired data from TAILS
3. Join your data to your shapefile in ArcGIS

♦ Actions needed to use TAILS data in ArcMap
1. Download your base shapefile from TAILS
2. Download your desired data from TAILS
3. Join your data to your shapefile in ArcGIS

Data added to ArcMap
Toggles to “Source”

In this example, we exported and added Lead Staff for FY 2010 only
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Using ArcMap as a TAILS extension

How it’s done
♦ Actions needed to use TAILS data in ArcMap

1. Download your base shapefile from TAILS
2. Download your desired data from TAILS
3. Join your data to your shapefile in ArcGIS

♦ Actions needed to use TAILS data in ArcMap
1. Download your base shapefile from TAILS
2. Download your desired data from TAILS
3. Join your data to your shapefile in ArcGIS

Right-click on Shapefile
Select “Joins and Relates”
Select “Join”
Release mouse button
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Using ArcMap as a TAILS extension

How it’s done
♦ Actions needed to use TAILS data in ArcMap

1. Download your base shapefile from TAILS
2. Download your desired data from TAILS
3. Join your data to your shapefile in ArcGIS

♦ Actions needed to use TAILS data in ArcMap
1. Download your base shapefile from TAILS
2. Download your desired data from TAILS
3. Join your data to your shapefile in ArcGIS

Select the type of Join to perform
(Join attributes from a table)

Select shapefile field the Join will be based on 
(ACTIV_CODE)

Select the table to join to the shapefile
(Your Excel worksheet)

Select field in the table to base join on
(Activity_Code)

Select Join Option
(Keep only matching records)

Click OK
To learn more, click on “About Joining Data”
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Using ArcMap as a TAILS extension

How it’s done
♦ Actions needed to use TAILS data in ArcMap

1. Download your base shapefile from TAILS
2. Download your desired data from TAILS
3. Join your data to your shapefile in ArcGIS

♦ Actions needed to use TAILS data in ArcMap
1. Download your base shapefile from TAILS
2. Download your desired data from TAILS
3. Join your data to your shapefile in ArcGIS

Symbolize based on new Joined data (in this example, Staff_Lead 2010)
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Using ArcMap as a TAILS extension

How it’s done
♦ Actions needed to use TAILS data in ArcMap

1. Download your base shapefile from TAILS
2. Download your desired data from TAILS
3. Join your data to your shapefile in ArcGIS

Minimal attributes of a TAILS shapefile

Additional data from a TAILS Report

Joined attribute table

More data = more mapping fun ! 
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Using
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as
a TAILS extension



Shepherdstown, WV                                                               Logging System Design for ES Field Stations 
2011                                                                                                   National Conservation Training Center 
 

 3

TAILS Final GIS Project 
 

FROM THE TRAINING SERVER (https://ecos-training.fws.gov) 

 Go to Reports: Geographic Reports: Shapefiles of office and regional activities 

and download your office’s shapefile 

 Use WinZip to unzip (decompress) this file and extract the files 

 Open ArcMap and add the shapefile as a new layer 

 Add a base map to ArcMap from the ESRI Resource Center (File: Add data from 

ArcGIS online) 

 Symbolize the TAILS data layer by Activity Type (ACTIV_TYPE) 

 Add the National Highways (Highways) layer from the 

D:\CSP7202\TAILS\Shapefiles folder 

 Symbolize the Highway layer to 2 point, and select a red line color 

 Perform a select-by-location query to select any of your TAILS points that are 

within 10 miles of any Highway (refer to prior exercise on Select by Location) 

 Return to TAILS and run another report – Office Reports: All Modules: Activities 

by Staff (select for 2013) 

 Export the result to ArcMap 

 Open and review the result, name the worksheet “2013 Lead Staff” and Save as 

a true Excel file (and close Excel) 

 Return to ArcMap and add this Excel file, (and specifically the “2013 Lead Staff” 

worksheet). 

 Join the Excel file to the Shapefile using Joins and Relates: Join; base the join on 

the Activity Code (using the “ACTIV_CODE” from the Shapefile and 

“Activity_Code” from the Excel file and select “Keep only matching records”) 

 Symbolize the joined result  by individual staff lead ( using the “Staff_Lead” value 

field) 

 Alter the map however you desire (pan, zoom, etc) and export the map as a pdf 

(from File: Export Map) 

 Extra Credit:  Toggle to the Layout View and change the symbology base to 

“Lead_Agency_Tribe”, manipulate the map more (add a legend, a title, north 

arrow, etc) and export the map again (to a pdf) 
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